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Alberta Netcare Network User Guide 
The aim of the Alberta Netcare Electronic Health Record (EHR) is to improve the quality and 

cost-effectiveness of medication therapies delivered to Albertans. Within the EHR, the role of 

the Netcare Network is to link all physicians, pharmacies and healthcare facilities, as well as to 

enable the electronic exchange of medication and allergy information. This allows health care 

providers to have a common picture of each patient’s medication profile. 

Within the EHR, Alberta Netcare offers a secure, current and consolidated view of a patient’s 

medication profile. This profile is available to healthcare providers, including pharmacists 

through their own Kroll pharmacy system right while they are dealing with their patients. 

The Alberta Netcare patient medication profile includes drugs which have been prescribed and 

dispensed along with additional supporting information which may affect drug treatment, such 

as professional services, other medications, patient allergies/intolerances and supplementary 

notes. 

In support of creating a comprehensive patient medication profile, the Kroll application must 

send and receive data from Alberta Netcare. The underlying premise is to use system-to system 

messaging (i.e. CeRx HL7 Version 3 standard) to exchange information between Kroll and 

Alberta Netcare. 

Kroll Computer Systems, Inc. has been coordinating closely with Alberta Health and Wellness 

(AHW) and the Alberta Netcare to develop software that supports security, privacy and 

conformance standards set out by the province. Kroll is an authorized Pharmacy Management 

System (PMS) for Alberta Netcare EHR. This user guide provides instructions on how to navigate 

the Alberta Netcare Network using your Kroll Pharmacy Software. 
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Glossary 

To facilitate understanding of this user guide, the following glossary will list terms and 

abbreviations used throughout the document as defined by Alberta Netcare. 

AHW: Alberta Health and Wellness 

Dispense Number: Every dispense record created in Alberta Netcare is automatically assigned a 

unique Identifier (Dispense Number) which does not change. This dispense number is different 

from the Rx Number assigned to the prescription by Kroll. 

Clinically Relevant Prescription: The Netcare Safety and Usability Panel has defined rules for 

Netcare to calculate the clinical relevance of a prescription. These rules are based on the 

premise that a drug can remain in the patient’s system for a period of time (however brief) 

after the patient stops taking it. Netcare attempts to estimate the length of time a drug may be 

clinically relevant in the patient based the speculated completion of the patient taking the drug, 

combined with the FDB-defined half-life of the drug. 

EHR: Electronic Health Record – a compilation of systems provided by Alberta Netcare; giving 

pharmacies across the province access to key applications and their associated data sources. 

PCR: Provincial Client Registry - The Provincial Client Registry (PCR) is one component of the 

EHR, and provides access to the Person Directory (PD). To find the patient’s PHN, the pharmacy 

user must access the PD through PCR. Where PCR is referenced, it is for the purpose of 

retrieving demographic data from the PD. 

PD: Person Directory – The Alberta Netcare Person Directory is the definitive source of PHN. 

The PD application provides the ability to search for a person and display his/her demographic 

information (Also see PCR). 

PHN: Personal Health Number 

Netcare Patient Medication Profile: Also known throughout this document as the Alberta 

Netcare Patient Medication Profile, refers to the following data on Netcare: 

 Prescriptions 

 All Dispense for the above prescriptions 

 Other Medications 

 Allergies/Intolerances (including refuted) and associated notes 

 Patient Notes 
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RTI: Real Time Integration  

Prescription Number: Every prescription created in Netcare is automatically assigned a unique 
identifier (prescription number) which does not change. This Netcare prescription number is 
different from the one assigned by Kroll. If a prescription in Netcare is dispensed by multiple 
pharmacies, it is likely that each of those pharmacies will have a different local identifier for 
that prescription, but the Netcare prescription number does not change, regardless of where it 
is being dispensed (See also Dispense Number). 

Primary PHN: When a person is recognized by AHW to have been registered more than once 

(with multiple PHN’s), AHW designates one PHN as the Primary PHN, and links that person’s 

other (secondary) records to the primary PHN (See also Secondary PHN). 

Secondary PHN: When a person is recognized by AHW to have been registered more than once 

(with multiple PHN’s), AHW designates one PHN as the Primary PHN. All remaining records are 

considered to be Secondary. AHW links that person’s other (secondary) records to the primary 

PHN (See also Primary PHN). Secondary PHN records cannot be updated; they can only be 

viewed. 
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Kroll User Accounts 

In conformance with Alberta Netcare security standards, Kroll users must have a password 

associated with their user account; passwords must be used to log into a Kroll session. The 

enforcement of local passwords helps to keep patient information private and secure. 

Add a new Kroll user with an associated password as follows: 

 From any screen, go to Edit > Users and Groups. 1.

 Log in with an existing Kroll user that has permissions to ‘Change Users’. 2.

NOTE: If you have trouble with this step, call Kroll Software Support at 1-800-263-5876 (ext 
1) for assistance. 

 

 From the Edit Users and User Groups screen, click Ins or press Insert on the keyboard to 3.
add a new user.  

NOTE: Edit an existing user by highlighting the applicable entry and clicking or pressing F2 to 
call up the User Information window for editing. Delete an existing user by highlighting the 
applicable entry and clicking or pressing Del. 
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 Enter user information in the User Information screen: 4.

 Initials: Enter the initials of the user. 

 Name: Enter the full name of the user. 

NOTE: Users must have both a First and Last name entered 

 Disabled: This flag should be UNCHECKED if the user is actively using Kroll. 

 Expires on: Optionally add a date for when the user account will expire and become 
unusable. 

 Type: From the dropdown menu, select one of three options to define the user: 

o Licensed Technician  

o Pharmacist  

o Pharmacy Student 

o Pharmacist Intern  

o Pharmacy Tech Student  

o Pharmacy Assistant  

o IT Support  

 Pharmacist ID: This field is only available when the Type option is set to ‘Pharmacist’. 
Enter the pharmacist’s license number here. 

NOTE: When this field is available, it must be populated before saving and exiting the User 
Information window. 

 SecurID Username*: Enter the user’s RSA SecurID username. This username is used to 
log into the Netcare Network. 

 Network Username*: Enter the user’s Alberta Netcare EHR username. This username is 
used to log into the EHR, which includes the Alberta Netcare Network and Provincial 
Client Registry (PCR). 

 Portal User Name*: Enter the user’s Alberta Netcare Portal (ANP) username. This is the 
username that is used to login to the Netcare portal via a web browser or by selecting 
Network > Alberta Netcare Portal within the Kroll application.   

 Password: Enter a password to log into the Kroll Windows dispensary application. The 
password entered here must meet the password requirements set in File > 
Configuration > Store > Security. 

 Confirm Password: Re-enter the password that was entered in the Password field. 

 Password never expires: Place a check mark here so the password never expires. 

 Force password change on next login: Place a check mark here to prompt the user to 
change their password subsequent to the first successful login. 
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* This field is specific for Alberta Netcare EHR users only. 

 Select Ins from the Groups frame or press Insert on the keyboard to assign the user to one 5.
or more permissions groups.  

NOTE: Permissions Groups can be configured in File > Configuration > Permissions > <Select 
User Group>. 

 From the Add/Delete Groups screen, highlight the permissions group you would like to 6.
assign the user. Click Insert or press Enter on the keyboard to select the permissions group 
to the right hand side of the screen. 
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 Press Enter twice to save the new user. 7.
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User Preferences  

Netcare user preferences determine which contraindications (DUE messages) are returned by 

Netcare during the evaluation of a patient’s profile against a new dispense or 

allergy/intolerance addition.  Preferences such as the severity level, whether managements are 

required and how many days can pass before the same issue is displayed again, can be set. 

The Netcare User Preferences screen can be accessed via Network > Edit User Preferences or 

while editing the currently logged in user via Edit > Users and Groups. 

 

 

NOTE: The Network Preferences button will only appear on the User Information form if the 
user being edited is the currently logged in user (i.e., you cannot edit the network 
preferences for anyone but yourself.) 
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Either method will present you with the Edit Netcare User Preferences form. 

 

Each section shows this user’s current settings and the system default settings. Depending on 

the user’s role, settings that cannot be changed are shown in grey (closed) fields. Settings that 

can be changed are shown in white (open) fields. 

For each tab shown across the top and for each row containing a different severity or type, you 

can make the following adjustments: 

 Display contraindication when detected? Does this type of issue get presented to the 

user? 

 Require entry of management info? If the issue is raised, will Netcare require the user 

to manage it in order to continue? 

 Do not display for same short term drug and patient for ### days:  Once the issue is 

first presented, how many days should pass before the same issue for the same patient 

is presented to the user again? 

 Do not display for same continuous drug and patient for ### days:  Same as above, 

except for continuous (long term) drugs. 

After reviewing and making changes, click the Save button to send Netcare the new 

preferences. 

Note that, depending on your local FDB analysis setting found in File > Configuration > Store > 

FDB, the Kroll system is always performing local issue detection. If an issue is detected and 

presented to you, a pre-management message will be sent to Netcare along with the dispense.  

Should Netcare also detect the same issue, they will apply the pre-management and not return 
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a detected issue. This prevents you from having to manage the same issue twice: once for the 

local detection and then again, for Netcare. 

Login Warnings 

Upon logging into Netcare, you may be occasionally presented with warnings regarding 

outdated or changes having been made to your user preferences via the Netcare web viewer. 

 

 

To prevent these warning messages from appearing every time you login to Netcare, reset this 

warning by accessing the Netcare User Preferences form and clicking the Save button even if 

you choose not to make any changes. 
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Kroll Security Settings 

Kroll has implemented session ‘time outs’ in recognition of security protocols set out by Alberta 

Netcare to minimize the risk of unauthorized personnel accessing the system while a 

workstation is unattended. Examples of such threats include inappropriate browsing, 

unauthorized data modification or deletion, and malicious software installation. Kroll 

pharmacies using the EHR in Alberta will have their sessions automatically ‘time out’ after 30 

minutes of inactivity.  

Once a Kroll Session ‘times out’, the session will become hidden and replaced by a Kroll login 

prompt. The prompt will state the ‘Fill Session has been locked – Please re-identify yourself to 

re-enter’. The Pharmacy user will have to login using their Kroll user initials and password to 

retrieve the screen that was displayed before the ‘time out’ occurred.  

 

Kroll Security settings can be found under File > Configuration > Store > Security. Notice the 

following two options are grayed-out; these configurations have been hardcoded for 

pharmacies using Alberta Netcare in conformance with their security standards. 

 Require Password: All Kroll users must have a password to log into a Kroll session. 1.
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 Blank screen after 30 minutes: Kroll sessions will automatically ‘time out’ after 30 minutes 2.
of inactivity. 

 

Accessing the Netcare Network & EHR  

In order for Kroll to establish a connection with the Netcare Network, it must send a request to 

access the Netcare Server which requires a RSA User ID and Passcode. The RSA User ID is 

specific to each user and is entered once under the Kroll user account in the SecurID Username 

field. The Passcode is either the eight digit number from a RSA FOB application on you mobile 

device or consists of two components: a four-digit Personal Identification Number (P.I.N) and a 

six-digit dynamic number entered from a FOB device (the FOB number changes every 60 

seconds) which will allow access through the Netcare Firewall. The FOB device will look similar 

to the following:  
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The P.I.N and the FOB device can be obtained from Alberta Health and Wellness (AHW) 

subsequent to registration and user-identity confirmation. To ensure security and prevent 

unauthorized use, a user should never share their RSA User ID, Four-digit P.I.N. or key FOB with 

anyone. 

 

Following a successful login to the Netcare Network, Kroll will submit a request to access the 

EHR, which contains the Alberta Netcare Network and Provincial Client Registry (PCR). The 

user will need to provide an EHR Login ID and Password. The EHR Login ID is specific to each 

user and is entered once under the Kroll user account in the Network Username field. The EHR 

Password is set up with Alberta Health and Wellness (AHW), and must satisfy the following 

criteria: 

 Minimum length of 8 characters (subject to change as per AHW); 

 Must include a combination of three of the following four (subject to change as per 
AWH): 

o Alpha-upper case 

o Alpha-lower case 

o Numeric 

o Special character 

 Passwords must not contain an individual’s user name or full name; 

 Minimum of 24 iterations before password reuse. 

 
Once the user has successfully logged into the Netcare Network and the EHR, they may roam 

between Kroll sessions and workstations within the pharmacy to access Alberta Netcare. The 

user may logout of the EHR and log back in as often as needed for a period of up to 12 hours 

without losing the connection to the Netcare Network (i.e. without having to ‘FOB-in’ to the 
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Netcare Network). It is important to note that even with user activity, the maximum time 

allowed for an active session on the Netcare Network is 12 hours, at which time the user will 

have to renew their login using their Netcare User ID and ‘P.I.N. + FOB Device’. Connection to 

the EHR is shorter and set to timeout after two hours with no message activity. 

Kroll Windows Application

Netcare Network

   EHR

2. Netcare User ID &
P.I.N. # + Keyfob

PIN PCR3. EHR Login ID & Password1. Kroll User Initials & Password
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Any user trying to access Alberta Netcare from Kroll for the very first time will elicit the 

following Terms of Use and Disclaimer window. Read through the disclaimer carefully; If the 

user has no questions and agrees to the terms and conditions, place a check mark next to the 

statement ‘I agree to these terms and conditions’ and click OK or press Enter on the keyboard 

to continue. If the user does not accept the terms and conditions set out by Alberta Netcare, 

click Cancel or press Esc to do nothing and exit from the window. 
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No FOB-Mark Netcare Down  

In the event a user has forgotten their fob, they can choose the option No fob-Mark Netcare 

Down. 

 

This will bring up the No fob-Mark Netcare down window and the user must enter a mandatory 

reason for marking Netcare as down. Once a reason is entered, the Mark Netcare Down button 

will be available to choose.  

Note: This will mark Netcare down for ALL users. 
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On the bottom of the Krollwin screens, Netcare will have a red circle to indicate Netcare is 

down for all users. 

 

Any Rxs filled by the pharmacy will be added to the Pending Adjudication to be sent to Netcare 

when a user with a fob logs in or tomorrow when the marking the route as down expires. 
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A new user with a fob, will need to login to Netcare from the Network> SecureID Login menu in 

order to have Rxs send to the Network. 
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EHR Password Change & Expiry 

Alberta Netcare requires EHR Passwords to expire every 90 days (this is subject to change from 

AHW). Kroll will begin reminding the user of an impending password expiry 7 days prior to the 

actual password expiry date. The reminder prompt will look similar to the following and will 

appear when the user attempts to login to Alberta Netcare: 

 

At this point, the user can click OK or press Enter on the keyboard to bypass the warning and 

change the password at a later time; or click on Change Password to immediately change the 

EHR password. If the Change Password option is selected, the (Network) Password Change 

window will appear. The user will be required to enter their old password followed by the new 

password. Once all three password fields are filled out, click OK or press Enter to save and send 

the new password to Netcare. 

 

When the EHR password is past its expiry, users have no choice but to change their password 

when they attempt to access Netcare from Kroll. A prompt similar to the following will appear 

(notice the number of days will fall into the negative values to denote that the password is past 

due). 
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When changing passwords, users cannot reuse a password that has been used the past 24 

times. If the user enters a password that has been used in the previous 24 passwords, the 

following error message will appear: 

 

Click on Show Details 

 

KROLL HINT: Users can incorporate a 2-digit number within in their password and change 
the number sequentially each time it expires to facilitate the tracking of passwords that have 
been used previously. 
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Kroll also allows users to change their password at any time, on demand, as follows: 

 From the ALT+X Start screen go to Network > Change Password. 1.

 From the (Network) Password Change screen, enter the old password followed by the new 2.
password, and then re-type the new password. 
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 Click OK or press Enter to save the new EHR Password. Once the password change is 3.
complete, the following confirmation message will appear: 

 

Patient Search 

For the most part, searching for a patient in Kroll will function in the same manner as before 

Alberta Netcare integration. That being said, a few extra steps will be required to synchronize 

data between the local patient record and the Alberta Netcare patient record. It is of great 

importance to patient safety that the correct local patient record is linked to the associated PCR 

patient record because information will be updated to and from Netcare via this link. 

The most straight-forward and effective method of searching for a patient in Kroll is to enter 

their Personal Health Number (PHN) preceded by a number sign (e.g. #697189009). That being 

said, users can also use other patient demographics to search the local database for a patient. If 

no patient file is found in Kroll, the user must create a new file for the patient. Kroll then 

interacts with the Provincial Client Registry (PCR), a component of the EHR, to retrieve a list of 

Network patients that match the criteria entered in Kroll. PCR provides the patient 

demographic information required by the user to confirm the identity of the patient. The 

ultimate objective is to match the patient’s demographic data in Kroll with data in the PCR. 
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Patient
Pharmacy User

Search Patient in Kroll
Create Patient in 

Kroll
Not Found

Found

Verify local records with the 
Provincial Client Registry

Synchronize data from Provincial 
Client Registry with local records.

 

For pharmacies integrated with Alberta Netcare, there are five (5) possible scenarios that can 

be encountered when searching for a patient: 

 Scenario 1 – New Patient (Not Found in Kroll) 

 Scenario 2 – New Patient (Not Found in PCR) 

 Scenario 3 – Existing Local Patient (Not synchronized to PCR) 

 Scenario 4 – Existing Local Patient (Not Found In PCR) 

 Scenario 5 – Existing Local Patient Already Synced to PCR  

Scenario 1 – New Patient (Not Found in Kroll) 

 Search for the patient using the F3-Patient Search. 1.

 Verify that the patient does not exist on the local Kroll system, then press Ins on the 2.
keyboard or click Insert with the mouse to add the new patient file. 
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 To search the PCR for a matching patient, answer Yes when asked ‘Do you want to search 3.
the Network for this patient?’  

NOTE: If the user answers No, they will be brought directly to the F3-Patient Card for manual 
entry of patient information. 

 

 Input all available patient information into the (Network) Patient Search window and click 4.
Search or press Enter on the keyboard to search the PCR for the patient record.  

NOTE: When the Personal Health Number is not available, the ‘Last Name + Given Name’ or 
‘Last Name + Full Date of Birth’ must be provided in order to initiate the search. Searching 
by Middle Name is also an option; however, no separate field is present in Kroll. The middle 
name can be entered in the first name field or the combination of both the first and middle 
name can be placed in the first name field. Keep in mind that wildcard or partial name 
searches are not allowed. 

 

 If the search does not return any matching patient records, the user can perform an 5.
Advanced patient network search by placing a checkmark next to the Advanced flag.  

NOTE: If the user searches by Address, they need to include the City, Country and Postal 
Code, but not phone number. If the user searches by phone number, the other advanced 
fields are not required for input. 
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KROLL HINT: If no records are returned for the search criteria entered, the user will be shown a 

message indicating ‘No results found with the specified search criteria. If you have more 

information on this patient, please retry with additional search criteria’. 

 

KROLL HINT: If more than 5 patient records are returned from the search, the user will be 

shown a message indicating ‘If you cannot find an exact match in this list, please search again 

with more information such as date of birth or phone (Advanced)’. 
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 Select the matching patient from the PCR results by highlighting the entry and clicking 6.
Select or pressing Enter on the keyboard. 

 

 Upon clicking Select, the Patient Update screen will appear allowing users to select the 7.
information they want to update from the PCR into the local Kroll patient record. The first 
column displays current local patient information, the second column displays Network 
patient information, and the last column displays information from the Network that will be 
updated to the Local Kroll patient record. 
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 By default, any information that is missing or different between the Current Local column 8.
and the Network column will be flagged for updating. If the user does not want to update 
the local data with the Network data, uncheck the flag next to the applicable piece of 
information.  

 

KROLL HINT: If the information de-selected is required, the information will then be added to 

the plan alias filed for the Netcare plan.  

 Once the user has finished selecting the Network data that needs to be updated into the 9.
local patient record, click Update or press Enter on the keyboard. Selected patient 
information will be populated into the local Kroll file.  
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 Input other pertinent patient information (e.g. snap cap preference, plan information, 10.
height, weight etc.) and click Save or press Enter on the keyboard to save changes.  

 

Scenario 2 – New Patient (Not Found in PCR) 

 Search for the patient using the F3-Patient Search. 1.

 Verify that the patient does not exist in the local Kroll database, then click Ins or press 2.
Insert on the keyboard. 

 

 When asked ‘Do you want to search the Network for this patient?’ answer YES to search 3.
the PCR for a matching patient.  

 

 Input all available patient information into the Network Patient Search window and click 4.
Search or press Enter on the keyboard to search the PCR for the patient.  
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NOTE: When the Personal Health Number is not available, the ‘Last Name + Given Name’ or 
‘Last Name + Full Date of Birth’ must be provided in order to initiate the search. Searching 
by Middle Name is also an option; however, no separate field is present in Kroll. The middle 
name can be entered in the first name field or the combination of both the first and middle 
name can be placed in the first name field. Keep in mind that wildcard or partial name 
searches are not allowed. 

 

 If the search does not return any matching patient records, the user can perform an 5.
Advanced patient network search by placing a checkmark next to the Advanced flag.  

NOTE: If the user searches by Address, they need to include the City, Country and Postal 
Code, but not phone number. If the user searches by Phone number, the other advanced 
fields are not required for input. 
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KROLL HINT: If no records are returned for the search criteria entered, the user will be shown a 

message indicating ‘No results found with the specified search criteria. If you have more 

information on this patient, please retry with additional search criteria’. 

 

 If all available patient information has been entered to search for the patient and still no 6.
matching results are returned, click on Patient Not Found or CTRL+N. 

 

 If a PHN was not used in the Network patient search, a warning message will appear to let 7.
the user know that without a PHN, information will not be saved on Netcare. Patients will 
not have a PHN if they are an out of province patient, an animal patient, or if the patient 
has recently moved to Alberta and does not have a PHN yet. Click OK or press Enter to 
continue from the warning message. 
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 The user will be brought back to the Kroll patient file and presented with a window asking 8.
‘Is this a human patient?’  

 

 If the user answers ‘No’ (i.e. the patient is not human), the system will proceed to mark the 9.
patient as an animal under the General tab of the patient file. If the user answers ‘Yes’ (i.e. 
the patient is human) they will be brought back to the local patient file where they will 
proceed to enter supplementary patient information. 

 

 Fill out all necessary patient information and click Save or press Enter on the keyboard to 10.
save the patient file. Note that data will not be recorded on Alberta Netcare for this 
patient. 

 

  



    Alberta Netcare Network User Guide 

 

36 
 

Scenario 3 – Existing Local patient (Not Synchronized to PCR) 

 Search for the patient using the F3-Patient Search (this patient exists in the local Kroll 1.
system, but their data is not synchronized with the PCR). 
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 From the patient card, go to Network > Synchronize Patient and login with Kroll initials and 2.
password.  

 

KROLL HINT: Selecting the Profile option will also cause the Synch if the patient has not already 

been synchronized to the network.  

 Patient information from the local Kroll record will automatically be pulled into the 3.
(Network) Patient Search and used as search criteria. Click Search or press Enter on the 
keyboard to execute the Network search for the existing local patient. 

NOTE: If the PHN field is populated, the PHN will be the only criteria used to search for a 
matching patient in the PCR; all other search fields will be grayed out. 
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When the Personal Health Number is not available, the ‘Last Name + Given Name’ or ‘Last 

Name + Full Date of Birth’ must be provided in order to initiate the search. Searching by 

Middle Name is also an option; however, no separate field is present in Kroll. The middle name 

can be entered in the first name field or the combination of both the first and middle name can 

be placed in the first name field. Keep in mind that wildcard or partial name searches are not 

allowed. 

 If the search does not return any matching patient records, the user can perform an 4.
Advanced Network search by placing a check mark next to the Advanced flag.  

NOTE: If the user searches by Address, they need to include the City, Country and Postal 
Code, but not phone number. If the user searches by Phone number, the other advanced 
fields are not required for input. 

 

KROLL HINT: If no records are returned for the search criteria entered, the user will be shown a 

message indicating ‘No results found with the specified search criteria. If you have more 

information on this patient, please retry with additional search criteria’. 



    Alberta Netcare Network User Guide 

 

39 
 

 

KROLL HINT: If more than 5 patient records are returned from the search, the user will be 

shown a message indicating ‘If you cannot find an exact match in this list, please search again 

with more information such as date of birth or phone (Advanced)’.  
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 From the list of patients returned from the Network search, highlight the matching entry 5.
and click Select or press Enter on the keyboard to continue. 
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 From the Patient Update screen, place a check mark next to the Network information that 6.
you would like to update into your local Kroll patient record and click Update or press Enter 
on the keyboard. Users can bypass this step by not checking any of the checkboxes in the 
Network column, and clicking Skip or pressing Esc on the keyboard. 

NOTE: If the patient confirms that data returned in the Network column is incorrect, the 
pharmacist should contact Alberta Health and Wellness to report the discrepancy. 

 

 The Kroll patient card will automatically be saved with new information pulled from the 7.
Network (if any was selected).  

Scenario 4 – Existing Local Patient (Not Synchronized & Not 
Found in PCR) 

 Search for the patient using the F3-Patient Search; this patient exists locally in your Kroll 1.
database, but has not been synchronized with a Network patient record. 
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 From the patient card go to Network > Synchronize Patient and login with Kroll initials and 2.
password.  

 

 Patient information from the local Kroll record will automatically be pulled into the 3.
(Network) Patient Search and used as search criteria. Click Search or press Enter on the 
keyboard to search the PCR for a matching patient. 

NOTE: When the Personal Health Number is not available, the ‘Last Name + Given Name’ or 
‘Last Name + Full Date of Birth’ must be provided in order to initiate the search. Searching 
by Middle Name is also an option; however, no separate field is present in Kroll. The middle 
name can be entered in the first name field or the combination of both the first and middle 
name can be entered in the first name field. Keep in mind that wildcard or partial name 
searches are not allowed. 
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 If the search does not return any matching patient records and a PHN is not available, the 4.
user can perform an Advanced Network search by placing a check mark next to the 
Advanced flag.  

NOTE: If the user searches by Address, they need to include the City, Country and Postal 
Code, but not phone number. If the user searches by Phone number, the other advanced 
fields are not required for input. 

 

KROLL HINT: If no records are returned for the search criteria entered, the user will be shown a 

message indicating ‘No results found with the specified search criteria. If you have more 

information on this patient, please retry with additional search criteria’. 
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KROLL HINT: If more than 5 patient records are returned from the search, the user will be 

shown a message indicating ‘If you cannot find an exact match in this list, please search again 

with more information such as date of birth or phone (Advanced)’.  

 If an exhaustive search on the Network has been made for the local patient, but no records 5.
are found, select the Patient Not Found option.  

NOTE: If a PHN was not used as search criteria for the patient, a warning will appear to 
remind the user that no information regarding the patient will be saved on Alberta Netcare. 
Click OK to proceed to the local F3-Patient Card. 

 

 From the local F3-Patient Card, a blank NET-Alberta Netcare plan is automatically added so 6.
that prescriptions filled for the patient are still sent to Netcare, but logged as rejected. 
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Scenario 5 – Existing Local Patient Already Synched to PCR 

 Search for the patient using the F3-Patient search. 1.

 Go to Network > Synchronize Patient. 2.

 If the local patient is already synchronized with a patient in the PCR, a message will appear 3.
indicating ‘This patient is already synchronized to the network’. 

 

 Click OK or press Enter on the keyboard to continue. Information for this patient will be 4.
logged in Alberta Netcare. 

Handling Patients with Multiple Given Names 

Pharmacy users will often encounter situations where a patient will go by multiple names. For 

example, a patient may have registered with Alberta Netcare under the first name Robert, but 

would like the name on his vial labels to read Bobby. As well, women may register with Netcare 

using their maiden name, and then get married and adopt their spouse’s last name without 

informing Netcare. In situations like these, users can send one given name to Netcare and have 

another given name printed and recorded on the local Kroll patient file. This can be achieved as 

follows: 
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 Search for and call up the local F3-Patient card. 1.

 Enter the given name that the patient would like printed on the vial label in the First Name 2.
and/or Last Name field. 

 

 From the patient card, go to Network > Synchronize Patient and login with Kroll initials and 3.
password.  
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 Patient information from the local Kroll record will automatically be pulled into the 4.
(Network) Patient Search and used as search criteria. Click Search or press Enter on the 
keyboard to execute the Network search for the existing local patient. 

NOTE: If the PHN field is populated, the PHN will be the only criteria used to search for a 
matching patient in the PCR; all other search fields will be grayed out. When the Personal 
Health Number is not available, the ‘Last Name + Given Name’ or ‘Last Name + Full Date of 
Birth’ must be provided in order to initiate the search. Searching by Middle Name is also an 
option; however, no separate field is present in Kroll. The middle name can be entered in the 
first name field or the combination of both the first and middle name can be placed in the 
first name field. Keep in mind that wildcard or partial name searches are not allowed. 
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 From the Patient Update screen, place a check mark next to the Network information that 5.
you would like to update into your local Kroll patient record and click Update or press Enter 
on the keyboard. Users can bypass this step by not checking any of the checkboxes in the 
Network column, and clicking Skip or pressing Esc on the keyboard. 

NOTE: If the patient confirms that data returned in the Network column is incorrect, the 
pharmacist should contact Alberta Health and Wellness to report the discrepancy. 
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 When the Network Patient Profile is retrieved for the patient, the name selected to be 6.
printed on the vial label will be displayed. 

 

Alberta Netcare Patient Profile 

The Alberta Netcare Patient Profile consists of a current, consolidated view of the following: 

 Prescriptions; Paper and eRx 

 Dispenses against the above prescriptions 

 Other Medications (Not Dispensed Prescriptions) 

 Allergies/Intolerances 

 Patient Notes 

Supplementary information is also available from the Alberta Netcare Patient Profile including 

issues and managements relating to a prescription, professional services provided to the 

patient and notes concerning a prescription/dispense. 

  



    Alberta Netcare Network User Guide 

 

50 
 

Patient information on the Alberta Netcare Patient Profile may reside locally on the Kroll 

database, and/or on the Alberta Netcare database. Many of the patient’s records may be the 

same on both databases, and some data may exist on only one or the other. Users must be 

conscious of what is local data versus Network data. 

 

Network Rx entries on the Alberta Netcare Patient Profile will sometimes have ‘icons’ located 

on the upper left to denote where the inferred prescription came from: 

 The  icon indicates that the prescription was inferred from a Netcare Batch 

dispensing event; not an Alberta Netcare dispensing event from within in the EHR. 

 

 The  icon indicates that this is an electronic-authoritative order. The patient does 

not need to bring a paper prescription to the pharmacy 
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 The icon indicates that this isn’t an electronic or and the patient must present the 

paper prescription from the doctor. 

 

 The icon indicates that the prescription was inferred from an Alberta Blue Cross 

(ABC) dispensing event. 

 

 The icon indicates that the prescription was inferred from a Cancer Center 

dispensing event. 

 

Access the Alberta Netcare Patient Profile as follows: 

Quick access to the Clinically relevant Network Profile 

 Go to the F3-Patient card and select Network > Profile (or press ALT+K, then P on the 1.
keyboard) to access the clinically relevant Network profile. 
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 If the user has not yet signed into the Netcare Network and/or the EHR, he/she must sign in 2.
to one or both. If the user has already signed into the Netcare Network and EHR, they will 
not see the sign-in windows. 

NOTE: Users must be logged into the Netcare Network and the EHR to perform any kind of 
communication with EHR, not just to view the Alberta Netcare Patient Profile. 

 

 When Kroll is retrieving information from Alberta Netcare, a small progress window will 3.
appear displaying the action being performed at that moment. 
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An Alberta Netcare Patient Profile will look similar to the following: 

 

Supplementary notes about the Alberta Netcare Patient Medication Profile: 

 Users can ‘filter’ the medication entries coming back from Alberta Netcare by Status or 
Order Type. 
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 Place a check mark next to the Advanced flag to display advanced filter options (boxed 
in RED): 

 

 Users can ‘sort’ medication entries coming back from Alberta Netcare by Last Filled 
Date, Picked Up Date, Doctor, Netcare Order #, Order Date, and Drug. Click on the 
respective buttons to sort by the specified parameter. 

 

KROLL HINT: When the parameter being sorted is a Green triangle, entries are displayed in 

ascending order; when the parameter is a Red triangle, entries are displayed in descending 

order. Click on the parameter to change it from red to green or vice versa. 

 

Detailing a Prescription Entry on Alberta Netcare 

Once a user accesses the Alberta Netcare Patient Medication Profile, they may need to access 

the details of a particular prescription entry to obtain supplementary information such as: 

 Dispenses made against a prescription. 

 Prescription Issues and Managements 

 Dispense Notes 

 Drug indications 

 Refusal to fills 

Note that you cannot detail a prescription on the (Network) Patient Profile that is only present 

on the local Kroll database (i.e. has a ‘yellow-local’ data bar). There are four ways to detail a 

prescription (or any other Alberta Netcare entry for that matter): 
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 Use the mouse to double click the entry you would like to see details for. 1.

 Highlight the entry and click the Detail button on the bottom-left of the window. 2.

 

 Highlight the entry and press CTRL+D on the keyboard. 3.

 Right click on entry to access a menu list, and then click on Detail. 4.
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Regardless of how a user calls up the details of a prescription entry, the (Network) Medication 

Order Detail window will display supplementary information regarding the prescription and the 

related dispenses. Information contained in the (Network) Medication Order Detail window is 

organized into ‘tabs’ across the top of the window. Users can click on the tabs to access the 

associated information.  

 

Extra Functions from the Alberta Netcare Medication Profile 

Extra functions can be performed for Rx entries on the Alberta Netcare Patient Medication 

Profile. Extra functions are not available for local entries because they are not linked to Alberta 

Netcare. There are three ways to access Extra Functions from the Profile tab of the (Network) 

Patient Profile: 

 Right click on the selected entry to access the Extra Functions menu list. 1.
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 Highlight the applicable entry and click the Extra Functions button. 2.

 

 Highlight the applicable entry and press CTRL+X on the keyboard. 3.

The Extra Functions menu list will contain the following options: 

 

Create Local Rx 

Gives the user the ability to pull down an Rx from the Network to the local system and have the 

information populated on the local system. Please see section ‘How to fill eRx created on the 

Alberta Netcare GUI’ for more details on ‘Create Local Rx’. 

Refusal to Fill 

The Refusal to Fill message is used when a pharmacist decides they ‘will not’ or ‘cannot’ fill a 

prescription request for a patient. The intent of the message is to record refusal to fill decisions 

made as a result of ethical situations (e.g. suspected abuse, poly-pharmacy activities) and 

operational situations (e.g. product unavailable, incomplete data). That being said, the Refusal 

to Fill message can be used by the pharmacist in any situation he/she deems fit.  
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Once a refusal to fill is sent to Alberta Netcare, it will be viewed by everyone. Although the 

prescription has been refused by one provider can still be filled by another. A pre-populated list 

of Refusal Reasons is available for selection; users cannot enter a free-form reason in this field. 

 

Recall the details of a Refusal to Fill from the Alberta Netcare Patient Medication Profile by 

highlighting the prescription that was refused and clicking the Detail button which brings up the 

(Network) Medication Order Detail screen. From there, click on the Refusals tab; the reason 

for the refusal, date of refusal and the ‘Refuser’ will be displayed in this section. 

 

The Network Profile will indicate  for recorded refusal to fills. 
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Hold (Suspend) Rx 

A prescription is put ‘on hold’ when a pharmacist determines that the drug should not be taken 

by the patient for a specified interval of time. This identifies the intent that the therapy be 

continued at some point in the future, but should be ‘suspended’ for the period indicated on 

the hold. This can be done in response to a patient entering a hospital, drug-to-drug 

interactions, duplicate therapies, etc. The request to put an Rx on hold can be sent throughout 

the prescription lifecycle. Note that user can hold an Rx that is already on hold; Alberta Netcare 

simply replaces the previous hold with a new one. A prescription that is placed ‘on hold’ will 

have a status of Suspended on the (Network) Patient Profile. 

 

There are two scenarios for placing an Rx on hold:  

a) Network Rx not assigned to the local pharmacy;  

b) Network Rx assigned to local pharmacy.  
 

Hold (Suspend) Network Rx not assigned to the Local Pharmacy 
 
1. Highlight the Rx from the (Network) Patient Profile and select Hold (Suspend) Rx from the Extra 
Functions menu.  
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2. The Hold Network Rx form will appear.  

 

 
a) In the Effective Date field, enter the date that the hold begins (i.e., when the patient should 
stop taking the medication).  

b) In the End Date field, optionally enter the date that the hold ends (leaving this field blank 
means that the hold is indefinite).  

c) From the Reason Code field, access the dropdown menu and select an option to explain why 
the prescription was placed on hold.  
 

 Click OK or press Enter on the keyboard to execute the hold.  4.

NOTE: The Reason Code field cannot be populated free-form. A selection must be made 
from one of the reasons provided. 
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Hold (Suspend) Network Rx Assigned to the Local Pharmacy  

 
An Rx that was created or dispensed locally has to be put on hold locally. If an attempt is made 

to hold a local Rx on the Network, an error message will be displayed. 

1. From the local patient profile, highlight the Rx to suspend and select Extra Functions > 
Suspend.  
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This will open the Suspend Rx(s) window. In the Date field, enter the date that the hold begins 

(i.e. when the patient should stop taking the medication). Under the Resume Date, optionally 

enter the date that the hold ends; leaving this field blank means that the length of the hold is 

indefinite. From the Reason field, access the dropdown menu and select an option to explain 

why the prescription was placed on hold. Click on Suspend Eligible Rxs or press Enter the 

Reason field must be populated in order to save and send the Hold (Suspend) Rx message. This 

field cannot be populated free-form, and a selection must be made from one of the reasons 

provided. 
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The local profile will show the Rx as Suspended. 

 

On the Network Patient Profile the Rx is now Suspended. 

 

Release (Resume) Rx 

The option to Release (Resume) Rx is used to release prescriptions that are currently on hold 

(i.e. have a status of Suspended). For example, a patient who transitions from an inpatient 

situation back to the community may require held prescriptions to be ‘released’. The request to 

Release (Resume) Rx can be sent throughout the prescription lifecycle, but if the Rx is not 

currently ‘on hold’ and a Release (Resume) Rx message is sent, an error will be returned.  

There are two scenarios for Releasing an Rx:  
 

a. Suspended Network Rx not assigned to the Local pharmacy  
b. Suspended Network Rx assigned to Local pharmacy  

 

Release (Resume) Suspended Network Rx 
 
1. To release a prescription that is on hold, highlight the suspended Rx from the (Network) Patient 
Profile and select Extra Functions > Release (Resume) Rx.  
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2. The Release Network Rx form will appear.  
 

 

a) In the Effective Date field, enter the date that the prescription was taken off hold (i.e., 
suspend) status.  

b)  From the Reason Code field, access the dropdown menu and select an available option to 
explain why the prescription was taken off hold.  

3. Click OK or press Enter on the keyboard to execute the Release Rx.  
 

NOTE: The Reason Code field cannot be populated free-form. A selection must be made 
from one of the reasons provided. 
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Release (Resume) Suspended Local Rx  

A local Rx that was has been suspended can only be Resumed / Released from the local patient 
profile.  

1. Go to patient profile, highlight Rx and select Extra Functions > Resume.  
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2. The Resume Rx(s) window will appear.  
Enter the date that prescription is to be reinstated. From the Reason field, access the 

dropdown menu and select an available option to explain why the prescription is being 

reinstated from a suspended status. Click Resume Eligible Rxs or press Enter on the keyboard 

to release the Rx from a suspended status. 

NOTE: The Reason field must be populated in order to save and send the Release (Resume) 
Rx message. This field cannot be populated free-form, and a selection must be made from 
one of the reasons provided.  

 

Once a held prescription is ‘resumed’, on the local system the Rx will be ‘Active’. 
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On the Network the Rx is Active: 

 

Revoke Dispensing Permission 

The option to Revoke Dispensing Permission is used when a provider decides to take away 

permission to dispense a prescription. Revoking permission to dispense implies that the patient 

should finish taking the remainder of the medication they have in their possession until it is 

gone, but no further dispenses are authorized against the prescription (i.e. all remaining refills 

are cancelled); this is different from ‘stopping’ a prescription which implies that the patient 

should stop taking the medication immediately, and should not finish the amount of medication 

they have on hand. 

To Revoke a prescription, highlight the Rx from the Local Patient Profile and select the option 

to Inactivate from the Extra Functions menu. This will call up the Inactivate Rx(s) window. 

Select option Revoke, this will call up Revoke Network dispensing permission window.  

 

The Reason Code is a required field; select an option to explain why the prescription is being 

revoked. Click OK or press Enter on the keyboard to execute the revocation; a prescription that 

has been revoked on Alberta Netcare will have a status of Revoked. 
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Locally prescription is inactivated and on the Network Profile the Rx is not fillable.  
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Detail the Rx and under the Status History tab, the Type and Reason for the revoke is 

displayed. 

 

Stop (Abort) Rx 

The option to Stop (Abort) Rx is used when a pharmacist or provider determines that a drug 

should no longer be dispensed and should no longer be taken by the patient immediately. 

Situations where a prescription may need to be stopped (i.e. aborted) are product recalls, 

duplicate therapy contraindication, or other therapy issues. The Stop (Abort) Rx message can 

be sent to Alberta Netcare throughout the prescription lifecycle. A prescription that has been 

stopped will have a status of Aborted. 

 

There are two scenarios for Aborting an Rx:  
 

a) Network Rx not assigned to the Local pharmacy  

b) Network Rx assigned to Local pharmacy  

Network Rx not assigned to the Local Pharmacy  

1. To stop/abort a prescription on Alberta Netcare, highlight the Rx from the (Network) 

Patient Profile and select the option to Stop(Abort) Rx from either the Extra Functions 

menu or Right clicking.  

2. The Stop Network Rx form will appear:  

 



    Alberta Netcare Network User Guide 

 

70 
 

a) In the Effective Date field, enter the date that the prescription was stopped (i.e.,aborted).  
b) From the Reason Code field, access the dropdown menu and select an option to explain 

why the prescription was stopped.  

 
3. Click OK or press Enter on the keyboard to execute the hold.  
 

Hold (Suspend) Network Rx Assigned to the Local Pharmacy 

1. From the local patient profile, highlight the Rx>right click and choose option Inactivate 

 

2. Inactivate Rx(s) window appears. Choose option Stop(Abort) 
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3. Stop Network Rx window appears. From the Reason Code field, access the dropdown 

menu and select an available option to explain why the prescription is being aborted. 

Click OK or press Enter on the keyboard to execute the Stop (Abort) Rx. 

 

4. Rx is inactivated locally and on the Network Profile the Rx is not fillable.  

 

5. Detail the Rx and under the Status History tab, the Type and Reason for the Abort is 

displayed. 

 

NOTE: Advanced Network Profile only displays the Aborted prescriptions and not the 
Network Profile. 
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Add Note 

The option to Add Note is used to document additional information concerning a prescription 

or a dispense. Notes are primarily used to document error corrections, information change, or 

new information, but can be used for any reason deemed fit by the pharmacist. Once a note is 

added to a patient’s Alberta Netcare Profile, it will be shared with everyone. 

 To add a note to a prescription, highlight the Rx from the (Network) Patient Profile and 
select the option to Add Note from either Right Clicking or the Extra Functions menu. 
This will call up the (Network) Add Note to Record window.  
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 Similarly, to add a note to a Dispense, highlight the applicable Rx entry from the 
(Network) Patient Profile and detail the prescription. From the (Network) Medication 
Order Detail window, click on the Dispenses tab to see all the dispenses made against 
the prescription. Highlight the dispense you would like to add a Note and select the 
option to Add Note from the Extra Functions menu. This will call up the (Network) Add 
Note to Record window. 

 

From the (Network) Add Note to Record window, select a pre-populated reason for adding the 

note in the Reason for change field, or enter a free-form topic for the note. Enter the required 

Note and click OK or press Enter on the keyboard to save information on the patient’s Alberta 

Netcare Patient Medication Profile. 
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From the (Network) Patient Profile, users can easily determine which prescription entries have 

prescription notes attached to them by looking for a blue arrow located on the lower-left of the 

entry.  

 

Retrieve Prescription Notes by detailing the Rx entry to bring up the (Network) Medication 

Order Detail window and then clicking on the Notes tab.  

 

Retrieve Dispense Notes by detailing a prescription entry to call up the (Network) Medication 

Order Detail window and then accessing the Dispenses tab. Users can easily identify which 

dispense entry has a dispense note attached to it by looking for a blue arrow on the lower-left 

of the entry.  
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Retrieve Dispense Notes by detailing the dispense entry; this will call up the (Network) 

Medication Dispense Detail window. Click on the Notes tab to view the note(s) for the selected 

dispense. 

 

Refresh  

Refreshing the (Network) Patient Profile will retrieve the most current information from 

Alberta Netcare on demand. Users can see when the Alberta Netcare Patient Medication Profile 

was last refreshed from the Last Updated field located on the upper-right hand corner of the 

window. 
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If an Rx has since been filled for this patient, it will show on the bottom of the screen that 

Recent local events are not being shown. To update this screen hit F5 or right click and choose 

Refresh. 
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Allergies & Intolerance 

Recording patient allergies and intolerances on Alberta Netcare is an integral part of creating a 

comprehensive Electronic Health Record (EHR) for Albertans. The availability of this 

information allows pharmacists and other healthcare professionals to make optimal drug 

therapy decisions.  

With the integration of Alberta Netcare in Kroll Windows, any allergy or intolerance entered 

locally will automatically be sent to Alberta Netcare for clinical recording. Alberta Netcare 

accepts FDB Allergy Group codes or Ingredient codes; specific Medication codes are NOT 

accepted by Alberta Netcare and will be rejected with an error. 

Adding a New Allergy/Intolerance 

 Bring up the F3-Patient card of the patient that you need to add a new allergy/intolerance. 1.

 From the Allergies section of the patient card, click Ins or press Insert on the keyboard to 2.
call up the Select an Allergy window. 

 

Search for an allergy/intolerance from the Select an Allergy window and click Search or press 

Enter on the keyboard to obtain search results (e.g. Type ‘sulf’ to search for a Sulfonamide 

allergy/intolerance). 

NOTE: Options are available to search the criteria entered by ‘Starts With’ or ‘Contains’. 
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 From the search results; select the applicable Allergy Group or Ingredient by highlighting 3.
the entry and clicking Select or pressing Enter on the keyboard; this will bring up the (Local) 
Patient Allergy Information form. 

NOTE: Medication codes are not accepted by Alberta Netcare.  

 

 From the Patient Allergy Information window, verify the Source, Date, and Apply to all 4.
Allergies options. Enter any optional comments regarding the nature and severity of the 
allergy/intolerance; the user will have a choice on whether to transmit this local comment 
to Alberta Netcare later on.  
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 Once complete, click OK or press Enter on the keyboard to continue. 5.

 

 Kroll will automatically try to establish a connection with Alberta Netcare upon continuing 6.
from the (Local) Patient Allergy Information window. Log into the Netcare Network and/or 
EHR if prompted to do so. The (Network) Patient Profile will appear displaying allergy 
entries from the local Kroll system and from Alberta Netcare. 

 

The coloured data bars on the left side of each allergy/intolerance entry provides information 

on whether local records match Alberta Netcare records. Hover your mouse over the coloured 

data bars to identify which entries need to be syncronized. 
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 Red (Local): A red-local data bar indicates that the allergy/intolerance entry exists on 
the local system only, this information has not been recorded on Alberta Netcare and 
should be synchronized. 

 

 Yellow (Network): A yellow-network data bar indicates that the allergy/intolerance 
entry exists on Alberta Netcare only, this information has not been recorded locally in 
Kroll and should be synchronized. 

 

 Green (Synced): A green-synced data bar indicates that the allergy/intolerance entry 
exists locally and is synchronized with a Alberta Netcare allergy record. This is the 
desired outcome for all allergy/intolerance entries because it indicates consistency 
between local and Alberta Netcare records. 

 

 Grey (Network): A gray-network data bar indicates that an allergy/intolerance is 
refuted/expired on the network and does NOT need to be syncronized to the local 
system. 

 

 Subsequent to synchronizing local and network allergies/intolerances, click OK or press 7.
Enter on the keyboard to continue to the (Network) Add/Update Allergy window. 

 

 From the (Network) Add/Update Allergy window, fill out the details of the allergy. Note 8.
that required fields are marked with an asterisk (*). 
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 Allergy/Intolerance Type*: Select an allergy or intolerance type from the options 
available in the dropdown menu, 

o Allergy Selections: Drug Allergy, Environmental Allergy, Food Allergy. 

o Intolerance Selections: Drug Non-Allergy Intolerance, Environmental Non-
Allergy Intolerance, Food Non-Allergy Intolerance. 

 Severity*: Identify the severity of the indicated allergy/intolerance as High, Low or 
Moderate.  

 Certainty*: The certainty of an allergy/intolerance is either Suspected or Confirmed. 

 Reaction Date*: Enter the date the allergy/intolerance was acknowledged by the 
patient. The date is defaulted to the current date, but can be manually changed to an 
earlier date (not a future date). 

  



    Alberta Netcare Network User Guide 

 

82 
 

 Enter an optional comment in the Comment field. Note that comments entered locally in 9.
the Patient Allergy Information window will automatically be copied to this field, but can 
be manually removed before sending to Alberta Netcare. 

 

If the user is adding a new allergy, Alberta Netcare requires an allergic reaction to be recorded. 

Click on the Supporting Information tab to insert a reaction for the allergy.  

NOTE: Intolerances do NOT require reactions to be recorded so this step can be skipped for 
intolerance entries. 

 

a) From the Supporting Information tab click Ins or press Insert on the keyboard to 
bring up the (Network) Add/Edit Allergy Reported Reaction window.  
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b) From the Reaction dropdown menu, select one of the allergy reactions accepted by 
Alberta Netcare. Note that allergy reactions cannot be entered free-form. 

 

c) From the Severity dropdown menu, optionally select High, Low or Moderate to 
describe the intensity of the allergic reaction. 
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 From the (Network) Add/Update Allergy window, click OK or press Enter on the keyboard 10.
to save changes and to send the allergy record to Alberta Netcare. 

 

Synchronizing Network and Local Allergies/Intolerances 

Consistency between allergy/intolerance records in Kroll and Alberta Netcare is integral to the 

underlying purpose of a patient electronic health record. There are two scenarios where 

allergy/intolerance records will need to be synchronized so that Kroll entries are consistent with 

Alberta Netcare entries: 

 Allergy/Intolerance entries that exist in Alberta Netcare, but not in Kroll. 1.

 Allergy/Intolerance entries that exist in Kroll, but not in Alberta Netcare. 2.

Synchronizing a Alberta Netcare Allergy/Intolerance to Kroll 

 From the Allergies tab of the (Network) Patient Profile, identify entries with a Yellow 1.
(Network) data-bar; these entries do not exist locally on Kroll and need to be synchronized. 
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 Right click on the Yellow (Network) entry to call up the Extra Functions menu, and select 2.
the option to Synchronize. Selecting the option to Synchronize will bring up the Select the 
local allergy to link to window. 
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 From the Select the local allergy to link to window, a list of local Kroll allergy entries will be 3.
displayed. If the Yellow (Network) allergy entry matches one of the existing local allergies, 
highlight the local entry and click Select to synchronize the two records.  

NOTE: In our example, the Yellow (Network) allergy entry is for Macrolide Antibiotics. This 
allergy group does not exist in our local system because it is not listed in the Select the local 
allergy to link to window. 

 

 If the Yellow (Network) entry does NOT match any of the existing local allergies, click on 4.
Add to Local or press CTRL+A on the keyboard. 

 

 Once the Yellow (Network) allergy entry is synchronized to the local Kroll system, the data 5.
bar will change to Green (Synced). As well, the allergy will be added to the Allergies section 
of the local Kroll patient card.  
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Synchronizing a Kroll Allergy/Intolerance to Alberta Netcare 

 From the Allergies tab of the (Network) Patient Profile, identify entries with a Red (Local) 1.
data-bar; these entries do not exist on Alberta Netcare and need to be synchronized. 

 

 Right click the Red (Local) entry to call up the Extra Functions menu, and select the option 2.
to Synchronize. Selecting the option to Synchronize will bring up the Select the network 
allergy to link to window. 
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 From the Select the network allergy to link to window, a list of Alberta Netcare allergy 3.
entries will be displayed. Highlight the entry and click Select to synchronize the two records.  

 

 If the Red (Local) entry does NOT match any of the existing Alberta Netcare allergies, click 4.
on Add to Network or press CTRL+A on the keyboard. 
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 If Add to Network is selected above, the (Network) Add/Update Allergy window will 5.
appear. Fill out the details of the allergy (note that required fields are marked with an 
asterisk ‘*’). Once all necessary information regarding the allergy has been entered, click OK 
or press Enter to send the information to Alberta Netcare. 

 

 Once the Red (Local) allergy entry is synchronized to Alberta Netcare, the data bar will 6.
change to Green (Synced) on the (Network) Patient Profile. 

 

  



    Alberta Netcare Network User Guide 

 

90 
 

Refuting a Network Allergy/Intolerance 

Once an allergy/intolerance record is added in Alberta Netcare, it cannot be retracted (i.e. the 

record cannot be removed from the (Network) Allergies Profile). An allergy/intolerance record 

entered in error can only be refuted (i.e. the Alberta Netcare allergy entry will have a Gray 

(Network) data bar).  

If a user decides to remove an allergy/intolerance record locally in Kroll, they must ensure that 

the same allergy is refuted in Alberta Netcare. Refute an Alberta Netcare allergy/intolerance as 

follows: 

 Bring up the F3-Patient card of the patient you would like to refute an allergy/intolerance. 1.

 Locate the Allergies section of the F3-Patient card. 2.

 Highlight the allergy entry you would like to remove and click Del or press Delete on the 3.
keyboard. 

 

 The system will display the following message: 4.

 

 Answer YES if you want to continue removing the allergy/intolerance from Kroll and refute 5.
it on the Network. Answer NO if you do not want to continue removing the allergy. 
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 Once the Network allergy/intolerance has been successfully refuted, it will appear in the 6.
Allergies tab of the (Network) Patient Profile with a Gray (Network) data bar. 

 

Adding an Allergy and Intolerance for the Same Allergen 

Allergy is a reaction produced when the body meets a substance that elicits an immune 

response (e.g. a rash). Intolerance occurs when unpleasant symptoms arise after ingesting a 

substance that the body cannot break down (e.g. stomach upset). In other words, an allergy 

affects the body’s immune system while and intolerance generally affects the body’s 

metabolism. 

Add an allergy and intolerance for the same allergy group as follows: 

 From the F3-Patient Card, go to Network > Profile and log in with Kroll initials and 1.
password. 

 From the Allergies tab of the (Network) Patient Profile, highlight the allergy you want to 2.
also add as Intolerance (the example below uses Podophyllotoxin Analogues). Right click on 
the entry or select Extra Functions to Unsynchronize. 
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 Once the Allergy is Unsynchronized, the result will be a Red (Local) entry and a Yellow 3.
(Network) entry for the same allergen. 

 

 Highlight the Red (Local) entry and right click or press the Extra Functions button; select the 4.
option to Synchronize. 

 

  



    Alberta Netcare Network User Guide 

 

93 
 

 From the Select the network allergy to link to screen, select the option to Add to Network. 5.

 

 Fill out the (Network) Add/Update Allergy window for the Drug Non-Allergy Intolerance 6.
and click OK or press Enter to send information to Alberta Netcare. 

NOTE: Reported reactions do not need to be entered in the Supporting Information tab for 
‘Intolerance’ entries. 
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  The Drug Non-Allergy Intolerance entry should be synchronized to the network (i.e. the 7.
entry has a Green-Synced data bar). 

 

 Highlight the Yellow (Network) allergy entry and right click or press the Extra Functions 8.
button; select the option to Synchronize. 

 

 From the Select the local allergy to link to screen, highlight the local allergy you want to 9.
link the Network allergy to and click Select. 
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 The resulting Alberta Netcare allergies profile will have an ALLERGY and an INTOLERANCE 10.
synced to the Network for the same allergy group. 

 

Refuting an Allergy and Intolerance for the Same Allergen 

 Bring up the F3-Patient card of the patient you would like to refute an allergy/intolerance 1.
for. 

 Locate the Allergies section of the F3-Patient card. 2.

  



    Alberta Netcare Network User Guide 

 

96 
 

 Highlight the allergy entry you would like to remove and click Del or press Delete on the 3.
keyboard. 

 

 The system will display the following message: 4.

 

 Answer YES if you want to continue removing the allergy/intolerance from Kroll and 5.
refuting it on the Network. Answer NO if you do not want to continue removing the allergy. 

 If the user answers YES to the above question, an options window will appear: 6.
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a) Continue and refute the 2 network allergies/intolerances: Selecting this option 
will remove the allergy locally from Kroll and mark the Alberta Netcare allergy 
and intolerance as refuted (i.e. completed). Both the allergy and intolerance 
entry for the allergen will have a Gray (Network) data bar. 
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b) Abort and view the allergy profile to make changes manually: Selecting this option 
will bring the user to the patient’s Alberta Netcare Allergies Profile where the user 
can manually unsynchronize the Allergy and/or Intolerance entry and then delete 
the local allergy as needed. 

 

c) Abort: Selecting this option will bring the user back to the F3-Patient Card without 
carrying out any action. 
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Extra Functions from the Alberta Netcare Allergies Profile 

Extra functions can be performed for Network allergy entries listed on the Alberta Netcare 

Patient Profile. Extra functions are not available for local allergy entries because they are not 

linked to Alberta Netcare. There are three ways to access Extra Functions from the (Network) 

Patient Profile: 

 Right click the selected allergy entry to see the Extra Functions menu list. 1.
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 Highlight the applicable allergy entry and click the Extra Functions button. 2.

 

 Highlight the applicable allergy entry and press CTRL+X on the keyboard. The Extra 3.
Functions menu list for allergy entries will contain the following options: 
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Synchronize/Unsynchronize 

The option to Synchronize will create a link between a local allergy record and a Network 

allergy record. Only Yellow (Network) allergy records and Red (Local) allergy records will have 

the option to Synchronize; this process was explained in the section, ‘Synchronizing Network 

and Local Allergies’.  

The option to Unsynchronize will break the link between a local allergy record and a Network 

allergy record. Only Green (Synced) Network records have the option to Unsynchronize. When 

a Green (Synced) Network record is unsynchronized,  

 

Right Click & select Unsynchronize 

 

The resulting allergy profile will have a Yellow (Network) allergy entry and a Red (Local) allergy 

entry.

 

 

Add Note 

Users can add supplementary free-form notes to existing Network allergies by using the Add 

Note function. Add a note to a Network allergy record as follows: 

 From the Allergies tab of the (Network) Patient Profile, highlight the allergy that you want 1.
to add a note for. 
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 Access the Extra functions menu and select Add Note. This will call up the (Network) Add 2.
Note to Record window. 

 

 From the (Network) Add Note to Record window, optionally select a pre-populated Reason 3.
for change or enter a free-form topic for the note. 
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 Enter a free-form note in the Note field; press CTRL + Enter to start a new line. Click OK or 4.
press Enter on the keyboard to save and send the allergy note on Alberta Netcare. 

 

 Once the note has been successfully saved to the network allergy record in Alberta Netcare, 5.
the following message will appear: 

 

Get History 

The Get History function allows users to track the incremental changes made to a Network 

allergy record (e.g. displays when a note was added, when an allergy was refuted, etc.) 

 From the Allergies tab of the (Network) Patient Profile, highlight the allergy entry you want 1.
to Get History for. 
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 Access the Extra Functions menu and select the option to Get History. This will call up the 2.
Allergy History window. 

 

 The Allergy History screen will list an entry for every instance where a change in the allergy 3.
record has been made. 

NOTE: The date listed on the upper left hand corner of the entry denotes the date that the 
allergy record was changed. Changes made to allergy records are only logged by Alberta 
Netcare and not locally on Kroll. 
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 View the details of one Allergy History Entry versus another to track the changes that were 4.
made. See the details of an Allergy History Entry by highlighting an entry and clicking 
Details or pressing D on the keyboard; this will call up the (Network) Allergy Detail window. 

 

 Click the different tabs across the top of the window to view information in the respective 5.
tabs. Click OK or press Enter on the keyboard to exit from the (Network) Allergy Detail 
window. 

Update Allergy 

The option to Update Allergy allows users to add or change information on the Network allergy 

entry after it has been initially entered. Note that Network allergy information cannot be 

removed; only updated. Update a Network allergy entry as follows: 

 From the Allergies tab of the (Network) Patient Profile, highlight the allergy entry you want 1.
to update. 

 Access the Extra Functions menu and select the option to Update Allergy. This will call up 2.
the (Network) Add/Update Allergy window which is the same window users first entered 
allergy details.  
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NOTE: The Allergy/Intolerance Type is now grayed out and cannot be changed. If the user 
wishes to change the allergy/intolerance type, they will have to refute the existing record 
and add a new allergy/intolerance record. 
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 All white-open fields on the (Network) Add/Update Allergy window can be edited; 3.
including entries in the Supporting Information tab. Once all changes/modifications have 
been completed, click OK or press Enter to save the updated allergy information on Alberta 
Netcare.  

 

Detail 

Once a user accesses the Allergies tab of the (Network) Patient Profile, they may need to view 

the details of a particular allergy entry to obtain supplementary information such as: 

 Who, where and when the allergy record was recorded by/at? 

 What were the reported reactions? 

 What notes were added, if any? 

There are four ways to detail an allergy entry from the Alberta Netcare Patient Profile. Note 

that only Network allergies will have Network details; allergy entries that only exist locally on 

Kroll only will not have the option to Detail. 

 Use the mouse to double click on the allergy entry you would like to see details for. 1.

 Highlight the allergy entry and click the Detail button on the bottom-left of the window. 2.
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 Highlight the entry and press CTRL+D on the keyboard. 3.

 Right click on entry to access a menu list, and then select Detail. 4.
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Once the Network allergy has been detailed, the (Network) Allergy Detail window will be 

displayed. Click on the tabs at the top of the window to view respective information. Accessing 

the Supporting Information tab will show the Reported Reactions logged for the allergy. 

Accessing the Notes tab will display any supplementary free-from notes that were added to the 

allergy record. 
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Refresh 

Refreshing the (Network) Patient Profile will retrieve the most current information from 

Alberta Netcare on demand. Users can see when the Alberta Netcare Patient Profile was last 

refreshed from the Last Updated field located on the upper-right hand corner of the window. 

 

 Right click anywhere on the window to access the Extra Functions menu and select the 1.
option to Refresh.  

 

 Select Extra Functions > Refresh.  2.
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 Press F5 on the keyboard. 3.

 

Network Options from the F3-Patient Card 

Thus far, we have discussed the option to retrieve the Alberta Netcare Patient Profile from the 

Network menu located in the F3-Patient Card; however, there are a number of other options 

available from the Network menu that will be discussed in the subsections below. Note that 

selecting any option from the Network menu will instruct Kroll to communicate with Alberta 

Netcare. Information entered, changed or removed via these options will be transmitted to 

Alberta Netcare. 

Network options can be accessed from the F3-Patient Card under the Network dropdown 

menu: 
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Verify Patient Demographics 

The Verify Patient Demographics Network option is used to validate local patient information, 

such as Name, Address, Birthdate, Gender, and PHN against patient information on Alberta 

Netcare. Users will have the option to update their local patient profiles with the demographics 

listed in Alberta Netcare; however, users will NOT have the ability to update Alberta Netcare 

information via Kroll. 

 From the F3-Patient card go to Network > Verify Patient Demographics. Enter your Kroll 1.
initials and password. 

 

 The Patient Update window will appear with patient demographics listed in the rows, and 2.
three columns listing Current Local, Network and New Local patient information. 
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NOTE: If the Client Registry returns different information in the Family Name, Given Name, 
or Birthdate fields, the user will be forced to select continue and login to override verifying 
the correct patient.  

 

 

 From the Network column, place a check mark next to the Network patient information you 3.
want to update into your local record; otherwise, do not place a check mark in any of the 
boxes, and click Update. 
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 Once the all the applicable Network demographics have been flagged for updating into the 4.
local Kroll system, click Update or press Enter on the keyboard. 

 The flagged Network patient information will be pulled into the local F3-Patient Card and 5.
saved automatically. 

 

Professional Services  

 

Pharmacists perform many types of services for patients which they may record on their local 

Kroll system for their own use, and may also wish to record this information on Alberta Netcare 

to be viewed by other authorized providers.  

Some examples of professional services that could be recorded on Alberta Netcare include: 

Training on usage of a device such as blood glucose monitors or peak flow meters; home visits 

to assess patient compliance/over-under use/home supplies; or pre-filled syringes. 

A professional service may be recorded as a one-time event or may be recorded as an ongoing 

service with a date range. Examples of services with a date range would be regular home visits, 

or ongoing pre-fills of insulin syringes. Date range is meant to indicate the length of a service. 

Professional Service(s) can be added through 1 of 3 ways: 

 By selecting Medication Review/Dialogs from the right navigation pane on the Patient 
card. 



    Alberta Netcare Network User Guide 

 

115 
 

 

 By selecting Patient > View Medication Review/Dialogs.  
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 By selecting Network > Add Professional Service. 

  

These methods will bring up the Medication Review/Dialogs window. 

 

 From the Medication Review/Dialogs window, use the hot key ‘N’ or click New 1.
Review/Dialog to call up the Medication Review/Dialog form. 

 

 

 

 

 



    Alberta Netcare Network User Guide 

 

117 
 

 Select Professional Service from the menu, and Perform Now or Save for Later 2.

 

NOTE: Selecting Perform Now will immediately take you through the Professional Service 
recording process. Save for Later will create an entry in the Medication Review/Dialog 
profile to be completed at a later date and time.  

 Select the Professional Service type and complete with Comments as applicable.  3.
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 Click Finalize Review to complete the entry. 4.

 

The Medication Review completion dialog box will appear.  
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 The user is then prompted if they would like to send this to the Network 5.

 

 Complete the (Network) Add/Update Service form  6.

 

 Once the professional service has been successfully sent to Alberta Netcare, the following 7.
message will appear. 
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Retrieve Details of a Professional Service on Alberta Netcare 

Once a Professional Service is logged on Alberta Netcare, it can be retrieved as follows: 

 From the F3-Patient Card, go to Network > Advance Profile and log in with your Kroll 1.
initials. 

 From the Select the Profiles to query window, check the Professional Services and then 2.
click OK or press Enter to retrieve the (Network) Patient Profile. 

 

 From the (Network) Patient Profile, access the Services tab. 3.
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Double click/Right click/Detail on the applicable Professional Service entry; this will call up the 

(Network) professional Service Detail window. 

 

View Network Access Log 

Alberta Health & Wellness is at liberty to request information regarding when and why a 

patient’s Alberta Netcare profile (including medications, allergies, services and notes) was 

accessed.  

 From the F3-Patient card go to Network > View Network Access Log and sign in with your 1.
Kroll initials and password. 
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 The Network Access Log will display as follows with an option to print (per patient) if 2.
necessary: 

 

Synchronize Patient 

The Network option to Synchronize allows users to synchronize an existing local patient with an 

Alberta Netcare patient record. This option is most often be used by pharmacies who just 

integrated with Alberta Netcare and have a large database of patients who need to be 

synchronized with the Network. 

Synchronizing an existing local patient with Alberta Netcare is explained in the Patient 

Search: Scenario 3 – Existing Local patient (Not Synchronized to Alberta Netcare) section. 

Add EHR Data Alert Note  

Considering all of the various sources of information on Alberta Netcare, there is a possibility 

that a user may encounter a patient record that has incorrect data. For example, a pharmacist 

may be reviewing a patient’s medication profile and be informed by the patient that certain 

prescriptions on the profile were never prescribed to this patient. The pharmacist may be able 

to immediately correct the data if the errors were originated at this pharmacy, but if the 

erroneous data is not immediately correctable by this location, the pharmacy must inform the 

EHR Help Desk that there is an unresolved problem with data on the EHR. It is important that 

all users of the EHR who access this patient’s record be alerted that the data is incorrect and 

this is done via an EHR Alert Note. 
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When the EHR Help Desk receives a call from a pharmacy about a data problem, the help desk 

records this information in a Trouble Ticket # and alerts the Information Compliance and 

Access Unit (ICAU) of Alberta Health and Wellness. The ICAU reviews and investigates the 

Trouble Ticket. Based on their investigation, the ICAU will determine whether to instruct the 

pharmacy to create an EHR Data Alert. Once ICAU has confirmed that the data has been 

corrected, they follow-up to tell the pharmacy that the alert can be removed. 

*** EHR Alert Notes are ONLY to be created in consultation with the ICAU. EHR Data Alert 

Notes will only be used for patient data integrity issues. *** 

Add an EHR Data Alert Note via Kroll as follows: 

 From the F3-Patient card, go to Network > Add EHR Data Alert note. 1.
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 Log with your Kroll initials to call up the (Network) Add EHR Data Alert Note. 2.

NOTE: Only ONE EHR Data Alert note can be added for a given patient. If an EHR note 
already exists for the patient, another one cannot be added. 

 

 A message at the top of the (Network) Add EHR Data Alert Note window will remind the 3.
user that EHR Data Alert notes should be reported to the EHR Help Desk before 
proceeding. 

 In the Trouble Ticket # field, enter the ticket number provided by the EHR Help Desk in 4.
regards to the patient data integrity issue. This field must be populated in order to send the 
EHR Data Alert Note. 
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 Enter supplementary information regarding the data integrity issue in the Notes field. 5.

 

 Click OK or press Enter on the keyboard to record the EHR Data Alert Note on Alberta 6.
Netcare.  

 The EHR Data Alert Note will also be added to the local Comments section of the F3-Patient 7.
Card. 

 

If the EHR Data Alert Note was added to the Alberta Netcare Patient Profile from a different 

pharmacy, local users will see an Important Patient Comment window pop up when they 

access the network profile for the first time; they will NOT see the popup message upon 

subsequent network profile accesses. The window will display information entered by the 

person who reported the data integrity issue from the other pharmacy. Click OK or press Enter 

on the keyboard to continue from the Important Patient Comment window. 
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Users in the Pharmaceutical Information Network GUI will see the following Alert on a Patient’s 

file. 
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Retrieve an EHR Data Alert Note 

Once transmitted to Alberta Netcare, the EHR Data Alert Note can be retrieved from the Notes 

tab of the (Network) Patient Profile on demand as follows: 

 From the F3-Patient card, go to Network > Profile. From the (Network) Patient Profile, click 1.
on the Notes tab. EHR Data Alert notes will be identified with ‘EHR Data Alert’ highlighted 
in RED. 
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 Detail the EHR Data Alert Note to view comprehensive information regarding the EHR Data 2.
Alert. 
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Removing an EHR Data Alert Note 

Once ICAU confirms that erroneous data on a Patient’s Alberta Netcare Profile has been 

corrected, they will follow-up by calling the pharmacy to let them know that the EHR Data Alert 

Note can be removed. The EHR Data Alert is the only type of patient note that can be removed 

by a different user in the same facility as where the note was created. 

Remove an EHR Data Alert Note when instructed by the ICAU as follows: 

 From the F3-Patient card, highlight the EHR alert comment and click Del or press Delete on 1.
the keyboard to remove the EHR Date Alert Note. 

 

 Answer Yes to the question ‘Are you sure you want to delete this Comment EHR alert?’ 2.

 

 

  



    Alberta Netcare Network User Guide 

 

130 
 

 Select a reason for removing the note from the Select reason window. 3.

 

 Click OK or press Enter on the keyboard to remove the EHR Data Alert Note.  4.

 

Alberta Netcare Web Interface 

The Network option for Alberta Netcare Electronic Health Record Web Interface allows users 

to access the traditional Alberta Netcare Electronic Health Record website. 

1. From the F3-Patient card access Network > Alberta Netcare Portal. 
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2. The Alberta Netcare Electronic Health Record website will be automatically brought up 

in a browser : https://aaa.albertanetcare.ca/vpn/index-anc.html 

 

3. Login with your Alberta Netcare EHR username and passcode to access the EHR Portal 

Patient Card, Other Network functions 

Add Patient Note 

The option to Add Patient Note is used to document additional information concerning a 

patient. Patient notes can be used to record any medical/health information the pharmacy 

deems important enough or relevant enough to record on Alberta Netcare. Once a patient note 

is logged in Netcare network, it can be viewed by anyone with access to the Netcare Network. 

Adding a Patient Note 

1. From the Comments section of the F3-Patient Card, click Ins or press Insert on the 
keyboard. 

 

2. Select a Topic for the comment, and flag the options to Show On Rx, Print On Hardcopy, 
Alert, and/or Record on Netcare as necessary. Enter a free-form comment and click 
Save or press Enter on the keyboard to continue. 

https://aaa.albertanetcare.ca/vpn/index-anc.html
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NOTE: If Record on Netcare enabled it will sent to Netcare. If Record on Netcare is 
unchecked it will be stored locally only and will not be sent to Netcare. 

 

3. Once the note is saved, the (Network) Add Patient Note window will appear allowing 
the user to change the Note Type before transmitting to Netcare. 



    Alberta Netcare Network User Guide 

 

133 
 

 

4. Once the Note Type has been selected from the (Network) Add Patient Note window, 

click OK or press Enter on the keyboard to transmit the Patient Note to Netcare.  
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Removing a Patient Note from Kroll and Alberta Netcare 

If the user decides to remove a patient note locally on Kroll, they must ensure that the note is 

removed from Alberta Netcare as well, and vice versa, to ensure synchronicity between local 

and Network patient data. There are two ways to remove a patient note from Kroll and Alberta 

Netcare. 

Method 1 

1. From the F3-Patient card, highlight the comment that you would like to remove and 
click Del or press Delete on the keyboard. 

 

2. The user will be asked if they are sure they want to delete this comment. 

 If the user answers YES, the comment will be removed locally and on Alberta Netcare. 

 If the user answers NO, the comment will not be deleted from Kroll or Alberta Netcare.  

 

3. If the user answers YES to the above question, they will be prompted to select a pre-
populated reason for deleting the patient note.  

 

4. Once a reason for deleting the patient note has been selected, click OK or press Enter 
on the keyboard Patient Note is removed successfully. 
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Method 2 

1. From the F3-Patient Card, go to Network > Profile and log in with your Kroll initials and 
password. 

2. Access the Notes tab from the (Network) Patient Profile. 

 

3. Right click on the Patient Note you would like to remove and select the option to 
Remove Patient Note. 

 

4. The user will be prompted to select a pre-populated reason for deleting the patient 
note.  
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5. Once a reason for deleting the patient note has been selected, click OK or press Enter 
on the keyboard to continue.  

NOTE: Removing the Patient Note directly from the (Network) Patient Profile will change 
the Patient note on Kroll to local only.  
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Synchronizing Kroll and Alberta Netcare Patient Notes 

It is the aim of Alberta Netcare that all clinically relevant medical and/or health related patient 

notes residing in Alberta Netcare are pulled into the local system and vice-versa. This promotes 

a comprehensive patient profile for providers. The following section will show users how to 

synchronize local patient notes: 

1. From the F3-Patient Card, go to Network > Profile and log in with your Kroll initials and 
password. 

2. Access the Notes tab from the (Network) Patient Profile.  

 

NOTE: Notes currently showing as Red(Network) will automatically be added to the local 
system & synchronized with the Network by the Background Rx Service.  
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3. Right click the Yellow (Local) entry you wish to synchronize with Alberta Netcare (this is 
optional depending on the whether the user deems the patient note clinically relevant);  

 

4. The Select the Network patient comment to link to window will appear. If there is an 
existing Network comment that matches the local comment, highlight the Network 
comment and click Select to synchronize the two entries, otherwise click Add to 
Network. 

  

  



    Alberta Netcare Network User Guide 

 

139 
 

5. Once the Yellow (Local) or Red (Network) note entry is synchronized, it will have a 
Green (Synced) data bar. 
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Filling Prescriptions on Alberta Netcare 

All prescriptions filled for patients in Alberta should be sent to Alberta Netcare for clinical 

recording. With Alberta Netcare integration in Kroll, prescriptions should first be adjudicated to 

all fiscal plan(s) for financial reimbursement, and then sent to Netcare for clinical recording. The 

‘Cash’ plan will always come after the Netcare plan. This sequence of plans allows prescriptions 

to be billed online, and then logged on Alberta Netcare before passing down any monetary 

values to the patient in the form of cash. As well, in the event that the Netcare Network is 

down, users can bill the fiscal plans, print the label, and then place the Rx in a Network Pending 

Queue until the Netcare Network is back up; at which point the Rx can be completed. (See 

Section What happens when Alberta Netcare is Unavailable). 

 In order to send a prescription to Alberta Netcare via the Netcare plan, the patient will 
require a valid Personal Health Number (PHN). Enter the patient’s assigned PHN in the 
PHN field of the F3-Patient Card. 

 

 Once the Netcare plan has been added to the F3-Patient Card, it will default as the LAST 
plan. 
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NOTE: There is an option in File > Configuration > Store > Pricing that should be set to Make 
this plan Last. 

 

Filling a New Rx  

1. Fill out the patient, drug, doctor, SIG, dispense information, etc. as usual from the F12-
Filling screen.  
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2. Users may access Network > Edit Rx Order/Dispense Information to add supplementary 
information regarding the Dispense. 

 

a) Note: Add a Dispense Note to the Rx. 

 

b) Substitution Type: If a drug substitution was made for this Dispense, indicate 
whether it is a Formulary, Generic, or Therapeutic substitution.  
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c) Substitution Reason: If a drug substitution was made, indicate the reason for 
substituting from the pre-populated list. 

 

3. The NET-Alberta Netcare plan should be the LAST third party plan before ‘Cash’. 

NOTE: The Netcare plan is always marked as Drug Utilization Evaluation Only ‘DUE Only’ 
which means there is no financial adjudication involved. 

 

4. Once all the appropriate information is entered into the F12-Filling Screen, click F12-Fill 
Rx or press F12 on the keyboard to fill the prescription. 

The (Network) Patient Profile is automatically returned by Alberta Netcare for the first 

prescription filled after entering the F3-Patient Card (regardless of whether the Rx being filled 

is New or Refill). The (Network) Patient Profile will not be returned for subsequent Rxs unless 

the user escapes from the patient card, searches for another patient, and then returns to the 

original patient again. 
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5. Adjudication to the fiscal plan(s) will be completed first, and then the Rx will be sent to 
NET-Alberta Netcare for clinical recording. 

6. If there are no Detected Issues or Warnings that require management returned by 
Alberta Netcare, a prescription label will print. 
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Vial Labels 

For prescriptions sent to Alberta Netcare, there will be two additional pieces of information 

printed on the vial label; the Alberta Netcare Netcare Order Number and Netcare Dispense 

Number. These two numbers are the unique identifiers used to track prescription on the 

Network. These numbers are not stored on the local Kroll system, and can only be viewed from 

the vial label of the prescription. 

 

The Netcare Order number and Dispense number can be used to reference specific 

prescriptions or dispenses when speaking with a Netcare Helpdesk agent. The Netcare Order 

Number can also be used to search for a specific Rx Order within a Network Patient Profile. This 

is especially helpful when the Network patient profile has multiple prescriptions for the same 

drug, or if the profile is very large. 

Use the Netcare Order Number to search for a specific Rx on the Network Patient Profile as 

follows: 

1. From the F3-Patient card go to Network > Profile  

2. From the Network Patient Profile, check off the Advanced flag to reveal additional 
options for searching prescriptions in the medication profile.  
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On the right hand side of the window, look for the Netcare Order # search field. Type in the 

Netcare Order Number and click Filter, or press Enter on the keyboard. The Rx Order entry 

matching the Netcare Order Number will be returned on the Network Patient Profile. 

NOTE: Entering the Netcare Dispense Number in this field will not function to pull up the 
particular dispense entry. 

 

3. Detail the Rx Order by double clicking the entry, clicking the Detail button or pressing 
‘D’ on the keyboard to call up the Medication Order Detail - Dispenses form. The 
Netcare Dispense # is displayed on the far right-hand side.  
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Managing Issues 

When a user fills a prescription, local FDB interaction checking typically occurs before the Rx is 

sent to Netcare and locally Detected Issues are returned; if Detected Issues are returned, they 

must be managed. Users must manage Alberta Netcare Detected Issues before sending the 

prescription to Netcare. 

1. After everything has been filled in for the Rx, the user will click F12 to fill the Rx. 

2. Local FDB interaction checking occurs and when applicable, a Clinical Reports window 
will appear to display clinical warnings. Click on Proceed. 

 

3. Once the issues have been reviewed, the Pharmacist must now manage these issues on 
the Clinical Issue Summary. Issues may be managed one at a time with different 
managements.  
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Issues can also be managed all at once with one management that applies to all issues.

 

4. There may be issues that have to be managed on the Network that the Local system is 
unable to detect. For example Rxs/ Allergies added from other locations. They will be 
return on the CeRx Adjudication Response form. 

 

NOTE: If issues require management, under the Mgmt Req column they will be indicated 
with Yes. 

5. The CeRx Adjudication Response window contains three (3) options: P-View Network 
Profile, M-Manage, D-Detail. 

a) P-View Network Profile: Selecting this option will call up the (Network) Patient 
Profile so that the pharmacist can cross reference the Rx they are filling with the 
existing medications on the patient’s Alberta Netcare Medication Profile. 
Accessing the patient profile also allows the user to Stop Rxs, make adjustments 
to Allergies, etc. that could be causing Detected Issues or errors on the Rx being 
filled. 



    Alberta Netcare Network User Guide 

 

149 
 

b) D-Detail: Highlight a Detected Issues /Warning and press D on the keyboard to call 
up the (Network) Detected Issue Detail window which displays complete 
information regarding the issue. Click on the tabs across of the top of the (Network) 
Detected Issue Detail window to access respective information. Click OK or press 
Enter on the keyboard to return to the CeRx Adjudication Response window. 

 

c) M-Manage: Allows a user to manage Detected Issues on an individual basis. 
Highlight the Detected Issues you wish to manage and press M on the keyboard to 
access a list of reasons for bypassing the Detected Issues and continuing to fill the 
Rx. All Detected Issues returned by Alberta Netcare MUST be ‘managed’ in order to 
proceed with filling the prescription; ‘Warnings’ do NOT need to be ‘managed’. 
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6. Once a reason for bypassing the Detected Issues is selected from the pre-populated list 
of reasons, the user can enter supplementary information in the Description filed. 

 

7. The CeRx Adjudication Response window also allows a user to Multi-Manage issues 
that are returned by Alberta Netcare.  

 

8. From the Apply this to all unmanaged issues above menu, select the appropriate issue 
management.  
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9. Once a reason for bypassing the Detected Issues is selected from the pre-populated list 
of reasons, the user can enter supplementary information in the Comment field. 

 

10. Once ALL Detected Issues have been managed, continue sending the Rx to Alberta 
Netcare by clicking Send Issue Managements or by pressing Enter on the keyboard. 

NOTE: From the CeRx Adjudication Response window, users can click on Cancel Rx to 
reverse the prescription, or Back to the Rx to return to the F12-Filling screen. 

 

11. Once the Rx has been successfully logged in Alberta Netcare the Prescription Label will 
print. 
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View Issue Managements for a Prescription 

Users can retrieve the management code(s) used to address a Detected Issues by calling up the 

patient’s Alberta Netcare Medication Profile as follows: 

1. From the F3-Patient card, go to Network > Profile or use the shortcut keys Ctrl+F3. 

2. From the Alberta Netcare Medication Profile, users can identify which prescriptions 
have recorded Issues by looking for an orange arrow located on the left-hand side of the 
Rx entry. 

 

 

3. Retrieve Issue Managements by detailing the Rx entry from the (Network) Patient 
Profile to bring up the (Network) Medication Order Detail window and then click on the 
Issues tab.  
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4. Call up the Details of the Issue by highlighting the entry and clicking D-Detail, pressing D 
on the Keyboard, or double clicking on the entry. Click on the tabs located across the 
top of the (Network) Detected Issue Detail window to access supplementary 
information. 
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Filling an Rx created on the Alberta Netcare GUI 

The Create Local Rx function allows users to ‘pull’ prescriptions from a patient’s Alberta 

Netcare medication profile and fill it locally.  

 

Prescription information such as drug, doctor, SIG and dispense data are pulled from Alberta 

Netcare into the local Kroll F12-Filling screen. The Create Local Rx function can only be used for 

network prescription entries that do not exist in local system. If the user attempts to create a 

local Rx for an Alberta Netcare prescription that already exists locally, the following message 

will appear: 
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Use the ‘Create local Rx’ function as follows: 

1. From the patient’s Alberta Netcare Medication Profile, highlight one or check multiple 
Rxs you want to fill locally. 
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2. Select Extra Functions > Create Local Rx. 
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3. The Create Local Rx – Network Rx Order window will appear displaying the Alberta 
Netcare prescription information that will be inserted into the F12-Filling Screen. 
Information on this screen cannot be removed or changed. 

 

NOTE: If the system cannot immediately match information, searches prompting for the 
information will appear before this window appears.  
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4. The initial opening of the ‘Create Local Rx – Network Order’ the user has options to 
‘Use this sig code text in the Rx’ and ‘Copy From Rx’ which are no longer options on 
subsequent viewings.  
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5. The Create Local Rx – Network Rx Order window can be dragged and dropped to any 
location on the screen so that it can remain open for reference while filling the Rx. 

 

6. Compare the Information from the Network with that of the local system.  
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7. Continue to fill the Rx by clicking F12-Fill Rx or pressing F12 on the keyboard. 

 

NOTE: The user may recall the Create Local Rx – Network Rx Order window to view details 
of the Alberta Netcare prescription at any time via Network -> View ‘Create Local Rx’ 
Information or by the hot keys Shift+Ctrl+O 

Refilling an Rx 

Refill prescriptions are sent from Kroll in the same manner as prior to Netcare real time 

integration.  

Where a local Rx order is already present, the user would access the local Kroll patient profile 

(SHIFT+F3), highlight the prescription they would like to refill and click or press F-Refill to refill 

the Rx. 
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Transfer Rx from Other Store 

If an order has never been filled at this pharmacy and active prescription with repeats resides at 

another pharmacy, the user will need to transfer-in the prescription and pull the Rx Order from 

the Alberta Netcare Medication Profile into their local system as follows: 

1. Once the prescription has been transferred into the pharmacy via phone/fax/verbal, 
access the Patient‘s Alberta Netcare Medication Profile from Network > Profile. (or 
press ALT+K, then P on the keyboard) Highlight the Network Rx entry that has to be 
transferred into the pharmacy. 

 

2. Access Extra Functions by right clicking on the highlighted Network Rx and select the 
option to Create Local Rx. 
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3. Users will be prompted with a caution message ‘This order was last dispensed at 
another location’ Hit Enter or click on the ‘Continue’ button. 

 

4. Users will be prompted for the Store that they are receiving the transfer from. First Fill 
Date, Last Fill Date, & Total Original Fills will be pre-populated from the Network.  
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5. Select the applicable drug and doctor information from the local database. If the local 
database does not have the drug or doctor you are looking for, it will need to be added. 

 

6. The Create Local Rx – Network Rx Order window will appear displaying the Alberta 
Netcare prescription information that will be pulled into the local F12-Filling Screen. 
Information on this screen cannot be removed or changed. (Please see the Extra 
Functions from the Alberta Netcare Medication Profile – Create Local Rx section.) 
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7. Make any necessary changes to the prescription before clicking F12-Fill Rx or pressing 
F12 on the keyboard. 

 

NOTE: If the user would like to recall the Create Local Rx – Network Rx Order window to 
view details of the Alberta Netcare prescription, go to Network > View ‘Create Local Rx’ 
Information from the F12-Filling Screen or use the shortcut Keys Shift+Ctrl+O. 

 

 



    Alberta Netcare Network User Guide 

 

165 
 

8. Informational messages from the ‘Create Local Rx’ will be displayed in the Warnings Tab 
in the lower right hand corner of the screen. When the Rx has been completed and is 
ready to fill click F12-Fill Rx or press F12 on the keyboard to fill the prescription. 
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Unfill Rx 

When a patient requests the pharmacy to keep a record of the written prescription, but not fill 

the prescription until a later time, they are Unfilling the Rx or ‘deferring’ it. Only the originating 

prescriber can send the Rx to Alberta Netcare. For example, Unfilled Rxs written by a physician 

and entered by a pharmacy are not sent to Netcare. There is one exception - Unfilled Rxs 

written by the pharmacist and recorded in the Kroll system by the writing pharmacist are sent 

to Netcare. (See section Pharmacist Prescribe – Unfills) 

Fill out the patient, drug, doctor, SIG and dispense information on the F12-Filling screen and 

mark the Rx to be Unfilled from the Rx dropdown menu. Click or press F12 to Unfill the Rx. 

 

The Unfilled prescription will not be logged on Alberta Netcare upon clicking F12-Unfill Rx 

because the user entering the Rx is not the prescriber of the Rx. It will reside locally in Kroll until 

it is filled and dispensed to the patient at a later time.  

If the user accesses the (Network) Patient Profile from Network > Profile, they will see the 

Unfilled Rx entry has a Yellow (Local) data bar. 
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On the first fill of an Unfilled Rx, an Inferred Rx is created. Inferred means the Rx Order and 

Dispense are created at the same time. 
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Pharmacist Prescribe  

A Pharmacist who is licensed to prescribe prescriptions can create and dispense through the 

Kroll System. A paper prescription is generated at the end of this process. 

Input all the information for the prescription ensuring that the prescriber is the prescribing 

pharmacist and the User initials are the same as the prescriber. Once everything has been 

inputted, the user will hit Enter. The Rx Order/ Dispensing Information will open. Make any 

adjustments/notes as required. Click OK. 
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If everything is successful, a prescription label will print along with the Paper Prescription. The 

hardcopy should be attached to this and filed. 
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Pharmacist Prescribe - Unfills 

 Unfilled Pharmacist Prescribe Rxs are recorded on the network.  
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Transfer Rx to Another Store 

1. From the patient’s local profile, select Extra Functions > Transfer Rx to Another Store. 

 

2. Complete the Transfer Out Rx(s) form as required. 
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3. Select to print or not print the Transfer Report. 

 

4. The Rx will now display as ‘Inact (Transferred)’ in the local profile. 

 

NOTE: The Rx order will still display as belonging to this pharmacy, until transferred by the 
receiving pharmacy.  
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Filling an Rx for Other Medication (Not Dispensed Rx) 

Medications such as Gravol, Baby Aspirin, Vitamins, Tylenol #1, etc. that are taken by the 

patient, but not actually filled by the dispensary are considered ‘other medications’. Kroll 

denotes prescriptions filled with ‘other medications’ by marking them as Not Dispensed. Not 

Dispensed Rxs are logged on Alberta Netcare as follows: 

1. Fill out the F12-Filling screen with the patient, ‘other medication’, doctor, SIG and 
dispense information as usual. 
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2. Click F12-Fill Rx or press F12 on the keyboard to fill the Not Dispensed Rx and to record it 
on Alberta Netcare. Remember to include the NET-Alberta Netcare plan in the 
prescription. 

 

3. Once the Not Dispensed Rx is successfully logged on Alberta Netcare, a Not Dispensed 
label will print. 

4. A Not Dispensed Rx will look slightly different from a regular Rx entry on the (Network) 
Patient Profile. Access the (Network) Patient Profile from Network > Profile; the entry 

for the Rx filled for an ‘other medication’ is marked with , and will be labeled as 
‘Other medication’. 

NOTE: Entries for Other Medications are not fillable. They can be refilled on the local system 
which creates on new entry on the Network. 
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5. The days supply sent to Alberta Netcare is either 90 or 540 even though locally a 
different days supply has been entered. Days supply is sent as 90 for short term duration 
and 540 will be send for long term duration. 

 

Natural Health Products 

A Natural Product Number (NPN) is assigned by Health Canada to a product whose 

manufacturer has submitted enough human evidence to support the health claims they have 

declared. Drug cards for NPNs must have the DIN type set to NPN. 

1. In the F5-Drug Card for the natural health product, set the DIN Type to NPN. 

 

2. Click Save or press Enter from the F5-Drug Card to save any changes that were made.  
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Filling an Rx for an NPN 

Natural health products that are dispensed to patients can be recorded on Alberta Netcare 

through Kroll as follows: 

1. Start a new prescription and fill out the patient, natural health product, doctor, SIG and 
dispense information for the prescription as usual. 

 

2. Click F12-Fill Rx or press F12 on the keyboard to fill the prescription for the natural 
health product.  
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Filling an Rx for a Mixture 

When sending a mixture to Alberta Netcare, components within the mixture are identified 

through textual format only. For example, in a mixture of ‘1% Hydrocortisone Powder In 

Clotrimaderm Cream’, only the ingredient descriptions will be sent and logged on the Network; 

the DINs are not recorded. 

Mixtures are entered into Kroll using the same protocol as before Alberta Netcare real time 

integration. The following screen shot depicts a mixture for ‘1% Hydrocortisone Powder In 

Clotrimaderm Cream’. 

 

Pseudo DINs are NOT required for submission to the NET-Alberta Netcare plan. Existing 

pseudo DINs for third-party plans will work in the same manner as before Alberta Netcare 

integration. 
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A mixture prescription will be entered and filled as usual with the NET-Alberta Netcare plan 

listed as the last real-time plan before ‘Cash’. 

 

Successful submission of the mixture prescription to Alberta Netcare will result in a Prescription 

label printing. 
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View Mixture Details from Network Profile 

To view the mixture prescription from the Alberta Netcare medication profile, go back to the 

F3-Patient Card and access Network > Profile and log in with your Kroll initials and password. 

From the (Network) Patient Profile, highlight the mixture prescription and press D or click 

Detail on the bottom of the screen to call up the (Network) Medication Order Detail window 

which displays the particulars of the mixture prescription.  

 

From the (Network) Medication Order Detail window medication details do not display 

information on DINs; only the mixture name and description will be listed. Click OK or press 

Enter to return to the (Network) Patient Profile. 

NOTE: For mixture names or descriptions that are very long, hover the mouse pointer over 
the respective field and a fly over will display the entire field information. 
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Filling an Rx for a Device 

Devices are non-drug products or drug delivery aids such as diabetic strips, lancets, alcohol 

swabs, compression stockings, syringes, etc. When a prescription is filled for a device it is NOT 

sent to Alberta Netcare. Drug cards for devices must be set up with Device Flag as follows: 

1. Bring up the F5-Drug card for a device by performing an F5 drug search. 

 

2. Ensure the Device flag is checked. 

 

3. Click Save or press Enter on the keyboard to save changes made to the F5-Drug card. 
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4. Start a new prescription and fill out the patient, device, doctor, SIG and dispense 
information for the prescription as usual. 

 

NOTE: Devices are not sent to Alberta Netcare, therefore the Net plan is automatically 
removed. 

5. Click F12-Fill Rx or press F12 on the keyboard to complete the Rx.  

6. The prescription will bypass Alberta Netcare. When you access the (Network) Patient 
Profile, the Device Rx will appear with a Yellow (Local) data bar because it only resides 
locally on Kroll. 
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Filling an Rx for an Out of Province Patient 

Patients from out of the country/province that do not have a valid Alberta Personal Health 

Number (PHN) will not have their dispense data recorded on Netcare; however, the dispense is 

still sent to Alberta Netcare to allow logging of the request. Fill a prescription for an out of 

country/province patient as follows: 

1. Insert the out of province patient and search the Network for them. 
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2. If no results are found click Patient Not Found. 

 

3. A warning will appear that because the patient does not have a phn, no information will 
be recorded on Netcare Click OK. 

 

4. The new patient is inserted in Kroll, with the prompt Is this a human patient? Answer 
Yes. 
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5. Enter the patient information. A blank Netcare plan will be inserted automatically. 

 

6. Click F12 to fill an Rx. Fill in the Rx information noting the Netcare plan is inserted. Click 
F12 to fill.  

 

This Rx will still recorded on the Network but there will be no Network patient Profile to 
view. 
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Filling an Rx for an Animal 

Prescriptions filled for non-human patients are not recorded on Netcare. Pets in the database 

must have an animal indicatory turned on. Animal patients will not have a PHN and therefore 

no (Network) Patient Profile.  

 

1. From the F3-Patient card, ensure that the PHN field is blank. 

 

2. Go to the General tab and enable the flag for Animal.  
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NOTE: If the user is trying to save a new patient without populating the PHN field, Kroll will 
ask the user if this is a ‘human’ patient. If the user answers ‘no’, the animal flag in the Extra 
Info tab will automatically be checked. 

 

3. From the F3-Patient card, click Save or press Enter to save changes to the patient. 

4. Proceed to fill a prescription for the animal. There will not be a Netcare plan in the Rx, 
and the prescription will not be sent to Alberta Netcare. 

 

5. Click F12-Fill Rx or press F12 on the keyboard to fill the prescription for the animal. 

6. There will not be a (Network) Patient Profile for animal patients because there is no 
PHN. 
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Retrieving Dispense Records for an Rx Order 

Within Alberta Netcare, refilled prescriptions are considered ‘Dispenses’ against an ‘Rx Order’. 

Access the ‘Dispense’ made against an ‘Rx Order’ as follows: 

1. From the F3-Patient card, access Network > Profile to view the (Network) Patient 
Profile. 

2. Highlight the Rx that you would like to see ‘Dispense’ for and detail the Rx by pressing ‘D’ 
on the keyboard (just like in the local patient profile). 

 

3. From the (Network) Medication Order Detail window, click the Dispenses tab. 

NOTE: The bracketed number in the Dispense tab indicates how many entries are listed. In 
this particular Dispense Profile, the first fill was sent on 24-Jun-2011 at another pharmacy 
(Local = No). The second dispense is filled locally on 26-Jul-2011 (Local = Yes). 
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4. Users can Detail a Dispense to call up the (Network) Medication Dispense Detail just like 
they can detail an Rx Order in the following ways: 

d) Use the mouse to double click on the dispense entry you would like to see details 
for. 

e) Highlight the dispense entry and click the Detail button. 
f) Highlight the entry and press D on the keyboard. 
g) Right click on entry to access a menu list, and then click on Detail. 

 

 

5. The (Network) Medication Dispense Detail window will display information on the 
following: 

h) Dispense: Displays general Rx information regarding the refill. 
i) Pickup/Dispense: Displays information on whether a Dispense was picked up 

and if so by whom. 
j) Instructions: Displays the SIG on the dispense. 
k) Issues: Displays any management codes sent with the dispense. 
l) Notes: Displays dispense notes (this is different than patient notes or 

prescription notes) 
m) Status History: Displays changes in the status of the Rx. 
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Cancelling an Rx 

Cancelling a prescription in Kroll will mark the associated dispense as ‘aborted’ on Alberta 

Netcare. Cancel an Rx as follows: 

1. Call up the local patient profile from the F3-Patient Card by accessing Profile > All Rxs or 
pressing SHIFT+F3 on the keyboard. 

2. Highlight the Rx that needs to be cancelled and click C-Cancel or press C on the keyboard. 

 

3. If the correct prescription is being called up for cancellation, answer Yes when asked ‘Are 
you sure you want to Cancel this Rx?’ 

 

NOTE: Select the option to Cancel and Refill if you are looking to reverse the claim, modify it, 
and then resend it immediately. 

4. Log in and choose Make this Rx unfilled or Filled in Error- Remove from profile.  
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5. If you are cancelling the first fill of a prescription, the following screen will appear. Select 
the appropriate option: 

 

a) Make this Rx Unfilled: Selecting this option will mark the local Rx as ‘Unfilled’ 
and remove the dispense from Alberta Netcare because physician prescribed 
Unfilled Rxs are not recorded on Alberta Netcare.  

b) Filled in Error – Remove from profile: Selecting this option will mark the Rx as a 
‘mistake’ on the local system and place it into the SHIFT+F9 – Rxs Filled in Error 
profile. The Network entry will be retracted and will NOT appear in the 
(Network) Patient Profile.  

 

Pickups 

Pharmacy staff can log the date and time of when a prescription is physically picked up from a 

pharmacy and who the prescription was picked up by. This information can be entered in Kroll 

and sent to Alberta Netcare for clinical recording. 

Recording prescription pick-ups facilitate health care providers to promote compliancy and 

prevent or reduce medication abuse. Unless otherwise specified Stores using ‘Laser Labels No 

Workflow’ will have automated pickups enabled. Stores using customized workflow, may have 

manually enabled pickups. 

For more detailed information, please contact your helpdesk. 
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When the Alberta Netcare Network is Unavailable 

In the event that the Alberta Netcare Network is unavailable, Kroll will queue the transactions 

(e.g. sending allergies, sending prescriptions, sending dispenses, adding notes, etc.) in the order 

of creation so that they can be sent when the Network is available again.  

No new claims for a particular patient can be sent to Netcare until all queued claims for that 

patient have been sent to Netcare because a prior queued claim may have an impact on the 

result set of a subsequent claim (e.g. an allergy add request must be sent before more 

dispenses are sent because that may affect the outcomes of the Drug Utilization Evaluation 

(DUE) processing for those subsequent dispenses). 

When Netcare is unavailable, claims are queued in order of creation under F9-Workflow under 

Pending Adjudication located on the right tool bar. 

 

Users may select the option to ‘Show only Netcare Claims’ which will only display pending 

claims for Netcare. 

 

From the Pending Adjudication Queue, all claims that have not been sent to Netcare will be 

listed by an entry that provides information on the Transaction Type, the date/time the 

transaction was sent, who it was sent by and for which patient. On the top left of the window, a 

filter option is available to filter claims authored by a specific user, or by claims for a specific 

patient. Access the dropdown menu to view pending claims by one of the filter parameters 

listed. 
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Once Netcare is available again, users can go to the Pending Adjudication Queue and send all 

claims at once by clicking on Send/Review All or Send for current Patient. 

 

This sends the pending claims, and if there are no issues or interventions required by the user, 

the Pending Adjudication queue will clear. 
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Printing Labels for Prescriptions when Alberta Netcare is 
Unavailable 

When Alberta Netcare is unavailable, users can adjudicate claims to the fiscal plans first, print 

labels for dispensing, and then place the Rx in the Pending Network Queue to send to Alberta 

Netcare once the Network becomes available. Print a label for dispensing when Netcare is 

unavailable as follows: 

1. From the F12-Filling Screen, the plan sequence should list the fiscal plans first, then the 
NET-Alberta Netcare plan, followed lastly by the Cash plan. 

 

2. Click F12-Fill Rx or press F12 on the keyboard to initiate adjudication of the prescription. 
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3. A response screen will appear indicating ‘Unable to connect to the remote server.’ 
Choose the option Send later. 

  

4. A second message will appear asking ‘Do you want to mark the Alberta Netcare route as 
down?’ Answering Yes will cause all subsequent transactions to skip adjudication to NET-
Alberta Netcare; answering No will cause subsequent transactions to continue to 
attempt to send to NET-Alberta Netcare even though Alberta Netcare may be potentially 
unavailable. 
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5. Answering Yes will bring up the ‘When do want to retry this route?’ screen. A default 
date and time is entered but the user can adjust if it is desired. 

 

6. Kroll will display the Alberta Netcare Patient Profile that was last generated for the 
patient. (Anytime this profile is more than 2 Hours out of date it will display with a RED 
background in the Last Updated field.) This profile may be out of date - proceed with 
caution. 

 

7. Select an Option as to what to do with the Rx while Netcare is down. This will put the Rx 
in the appropriate queue. 
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8. The Rx will adjudicate through the fiscal plans for payment.  

9. Once Fiscal adjudication is complete, the prescription label will print.  

10. The NET-Alberta Netcare portion of the Rx will be queued into the Pending Adjudication 
Queue found in F9-Workflow-Pending Adjudication. The transaction can be sent once 
Netcare is back up. 

 

Patients with Multiple PHNs 

Occasionally some Albertan patients will have more than one Personal Health Number (PHN). 

To prevent users from having to enter two patient cards for the same person as a result of the 

multiple PHNs, Kroll gives the user the option to view the Alberta Netcare patient profiles of the 

secondary or tertiary PHNs from one patient card. 

When adding/updating Patient Demographics for a patient with multiple PHN’s the user will 

see an additional field – Sec. PHN. 
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When the user selects to add/update, they will be prompted to view the Secondary PHN Profile. 

 

If the user chooses ‘Don’t View Profile’ the system proceeds with inserting the patient into the 

local database. If the user chooses to ‘View Profile’, the system requests an Alberta Netcare 

patient profile for the secondary PHN. If there were more than 2 PHNs, they would appear in 

this list and the user would highlight the one they wish to view the Alberta Netcare Patient 

profile for. 

 



    Alberta Netcare Network User Guide 

 

199 
 

If the user selects to view the profile of the Secondary PHN, a (Network) Patient Profile for the 

secondary PHN will appear. A RED bar at the top of the window will remind the user ‘This is a 

profile for the patient’s secondary PHN: #########’. 

 

Subsequent to reviewing the profile, click OK or press Enter on the keyboard to continue. The 

user will be brought back to the list of PHNs for the patient. At this point, choose the option to 

‘Don’t’ View Profile’ to proceed to the F3-Patient card. 
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On the F3-Patient card only the Primary PHN will be recorded and displayed. 

 

Users of patients with multiple PHNs will be prompted to view the secondary Alberta Netcare 

patient profiles when they fill Rxs for a patient the first time a patient profile is returned, 
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Electronic Authoritative Prescriptions – 
ePrescribing 

ePrescribed Rxs will be depicted by the  icon indicating ‘This is an electronic – authoritative 

order. A paper prescription is not required.’ 

Filling a Pharmacist Prescribed Rx  

11. From the F12-Filling Screen, enter the patient, drug, pharmacist, SIG, and dispense 
information for the prescription. The user will be prompted with the Rx Order/Dispense 
Information. By default the Electronic Authoritative (eRx) flag will be enabled. 

 

 

NOTE: There will be a yellow prescription warning indicating ‘This is a Pharmacist Prescribe 
– an Rx Order will be sent’. 
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If the pharmacist prescribe is successful, a prescription label will print along with the eRx 

Reference Report. This may be used as a placeholder for pharmacies using paper filing. 
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On the network, the order will have an  icon to indicate ‘This is an electronic – 

authoritative order. A paper prescription is not required.’ 

 

 

 


